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Introduction

I am using FreeCAD Version: 0.19 for Windows 64bit. 0.19 is recommended by most FreeCAD 
contributors and developers recommend. Download it from here 
https://github.com/FreeCAD/FreeCAD/releases/tag/0.19_pre and follow the installation as 
mentioned on the same page.

Impotrant Note
Since you started this, FreeCAD has changed so some things might no longer be in the same 
place or should be done a bit differently. So if you do not find the icon or menu item it as 
stated in this document, please do a little search. I’m am 100% sure you’ ll find it back. 
Among other things here is just one example: FreeCAD has changed how you move a part on 
the Part workbench: you now right-click the part in the file tree and then select Transform.

When you open FreeCAD, it defaults to a ‘start’ workbench which has limited tools but shows 
recent files and example files in the viewer window on the right-hand side. 

FreeCAD uses ‘workbenches’ which you can switch between. If you click the drop-down menu 
where it says ‘Start’, you will see all the installed workbenches. 

The idea of workbenches is simple: imagine a large workshop with multiple benches, and each 
bench has a different collection of tools focused around a theme. FreeCAD has workbenches 
with tools to make parts, create architecture, assemble collections of parts into assemblies, 
create toolpaths for CNC, create technical drawings, and much more. 
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The beauty of these workbenches is that FreeCAD automatically carries all your work between 
them when you switch benches. As you progress in FreeCAD, you will use more workbenches, 
and you might even install extra workbenches you discover in the FreeCAD community.
Going from Fusion360 to FreeCAD? 
Watch this 10-minute video https://www.youtube.com/watch?v=_GxJkB23ZHM
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First Design using Part workbench

To begin, click ‘Create new’ and the document viewer window will create an empty project in a 
new tab. Next, you are going to switch from the ‘start’ workbench to the ‘part’ workbench 
using the workbench drop-down menu. The part workbench is a good place to start to get 
oriented and to explore one of the simplest ways to make parts. Before you go too far, though, 
let’s explore how you navigate, zooming and moving objects, in the preview window. 
You should be able to see a collection of tool icons that contain yellow shapes of a cube, 
cylinder, sphere etc. Left-click on the cylinder icon and you should see a cylinder appear in the 
viewer window. It probably will have defaulted to a top view of the cylinder, so you may only 
see a circle as you are looking straight down from above. There are numerous ways to switch 
the viewpoint in FreeCAD. First, you can use the cube in the upper right-hand side of the 
preview window to move to view different faces. You can also use the blue ‘view’ icons that 
appear as a cube with a single face marked as solid in the toolbars. If you hover over the view 
icons, you get a description of the view type they relate to and also a number. This indicates 
that you can also swap views by just using the number buttons 1, 2, 3, and 4 on your 
keyboard.
 
Navigation 
However, a common way to navigate and select items and parts in FreeCAD is in the viewer 
window itself, and there are numerous different navigational styles available for you to choose 
from. If you hover over the viewer window and right-click, you can scroll to ‘navigational 
styles’ and a drop-down list appears. 

Some of the navigational styles are based on other CAD environments, so if you are used to 
using, for example, Blender, then you might prefer that style. You use the ‘gesture’ style option 
that gives left-click for rotation in the document window, right-click for moving, and the centre 
button/wheel is for zooming. Of course, you need an object like the cylinder you created to 
allow you to judge which navigational style suits you best.
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Set Up Your Workbench
The part workbench is used largely to create parts by combining solid primitive objects like the 
cylinder you created. It’s definitely a good place to start, but you may find as you learn 
more/other ways to create parts on different workbenches, you use this workbench less. 
Returning to the cylinder you created, you can see that on the left-hand side of the screen 
there is a file-tree-type view, and under the heading ‘unnamed project’, you can now see that 
‘cylinder’ is listed. 

You can single-left-click on this cylinder label in the file view to select the object, or you can 
click on the various faces and edges of the cylinder in the document window to select them. 
Clicking on the label in the drop-down menu, you should see that underneath this a new dialog 
box ‘Data’ appears with details about the dimensions and position of the cylinder. Initially, the 
first things you can change here are the radius and the height of the cylinder. Let’s imagine 
you are making a simple wheel for a toy car, and make the wheel radius 12 mm. Next, let’s set 
the height of the cylinder to 15 mm.
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Whole Holes
Click the cylinder tool once again and you’ll see another cylinder appear in the file tree view. 
You may not see the cylinder appear in the document viewer window, however, as it’s smaller 
than the other cylinder and is currently positioned inside it. If you left-click the new cylinder in 
the file tree view, it should appear highlighted in the document viewer window. Change the 
radius of the new cylinder to 1.5 mm and adjust the height to match the first cylinder, which 
was 15 mm. If you click anywhere off the image of the cylinders in the viewer window, you 
should now be able to see the ends of the cylinder you created in the top and bottom of the 
original cylinder.

Quick Tip: Hover your mouse over any tool icon in FreeCAD for a couple of seconds to get a 
text description of what the tool does. 
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Slicing And Dicing
Similar to most drawing and CAD packages, you can combine objects in multiple ways to 
create new objects. You should be able to see a selection of tool icons, some of which feature 
blue circles overlapping in different ways. Hovering over these icons, you should find one 
described ‘make a cut of two shapes’. You are going to use this tool to cut the 1.5 mm radius 
cylinder you just made out of the larger one. Select the larger cylinder first in the file tree and 
then hold either the SHIFT or the CTRL key down whilst you select the smaller cylinder. Once 
they are both selected, click the ‘make a cut of two shapes’ tool icon and a hole should appear 
through your first cylinder. If for any reason both cylinders disappear, it probably means you 
have selected them in the wrong order and have cut the larger cylinder out of the smaller one, 
which leaves no object behind! 
Press Ctrl + Z to undo and try again. The shortcuts may be different on your OS. 
NB: You can see, and change them in the Tools > Customize menu.

You should now see that in the file tree your cut object has been renamed to ‘Cut’. If you click 
the small arrow to the left of ‘Cut’, you should see a drop-down which contains both your 
original cylinders but greyed out. 

These objects, despite being components of a completed cut, can still be altered. 
For example, if you wanted to change the radius of the hole to 2 mm from its current 1.5 mm, 
you can do this without redoing the cut operation. Select the file tree name for the smaller 
cylinder, then press the SPACE bar. This should make the cylinder that made the hole visible in 
the viewer window. You can then use the dialog box to change the radius of the cylinder and 
then press the SPACE bar again to turn off the visibility of the object. This should reperform 
the cut with the new-sized cylinder. You can also change the position of the hole if needed by 
moving the object.
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Wheely Good
The wheel design looks a little unrefined, so let’s add some features to make it look a little 
cooler. Let’s create another cylinder and change the radius of this cylinder to 10 mm, and set 
its height to 3 mm. You are going to perform another cut with this object, but you want to 
move it to the top of the wheel design. To do this, double-click on the new cylinder object in 
the file tree. You should now see a Tab box called ‘Tasks’. In the dialogbox ‘Location’, you can 
now change x, y and z-values to move the cylinder around to the right position. 

This usually defaults to one millimetre, but you can set it to any step size you prefer. For 
example, in the case, if you set the Z-position to 12 mm, bringing the 3 mm-high cylinder 
flush with the top of the design. Whilst you don’t need it for the wheel, it’s worth having a play 
with it. When done, click ‘OK’

 
Next, perform a cut to remove the new cylinder from the design. 
You then continued to make the wheel look a little fancier by creating four more cylinders of 2 
by 12mm. You moved the four cylinders equally outwards by 5 mm from the centre of the 
wheel using the moving techniques you learnt earlier. You should end up with a simple wheel.
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Finishing Touches
the wheel is looking wheel-like, but the part workbench has some simple tools you can use to 
embellish it a little. You may have noticed in the viewer window that you can highlight/select 
either the faces or the edges of objects. Often you can also select corner points of objects, but 
as everything is circular in the wheel design, that doesn’t apply here. The part workbench has 
two nice tools for adding either fillets or chamfers to edges of objects. They appear as two tool 
icons: the fillet tool as a curved area between two flat surfaces, and the chamfer tool as an 
angled flat surface. In the viewer window, left-click to select the outside edge of the top of the 
wheel, and then click the fillet tool. In the dialog box, you can see a list of edges, including the 
selected edge. This is useful if you want to apply multiple fillets to multiple edges in one 
operation. You can also adjust the radius of the fillet in the dialog. You’ll leave ours at 1 mm 
and click OK to apply the fillet. Both the fillet and the chamfer tools can be used on either 
external or internal edges. As an example, let’s select the edge inside at the bottom of the 
large cut-out at the top of the wheel. Click the chamfer tool this time, and set the chamfer 
length to 0.5 mm and OK it. You should see that a nice internal chamfer has been created. 
Finally, you added a matching fillet to the bottom outside edge of the wheel.

Rename
Now you have the basic wheel design (it's called ‘fillet’ in the file hierarchy). Whilst you can 
click it to select the entire wheel, if you double-click it, this reopens the dialog for the fillet 
operation. This means that this part can be tricky to move. A common way to deal with this, 
which is also useful for us as you want to have four of the wheels, is to create simple copies of 
a part.
First, to help keep things orderly, let’s right-click on ‘fillet’, select ‘rename’, and call it ‘wheel’. 
Renaming this doesn’t change the fact that if you double-click it, it won’t open up the fillet 
dialog, but will help us track when you make multiple items.
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Create Copies
To create the copies, single-left-click ‘wheel’ in the file tree view to select the wheel and then 
go to the ‘part’ drop-down menu; select ‘create a copy’, then ‘create a simple copy’. Clicking 
this option will create a new ‘wheel001’. 

Clicking this option will create a new ‘wheel001’. If you double-click on wheel001, you can see 
that it can now be moved in the 3 axises as well as rotate as a separate item. The behaviour of 
the change you can set in the ‘Tasks’ tab. 

As you made a ‘simple copy’, your new wheel doesn’t contain the hierarchy of operations and 
objects your original has and also is not dynamically linked to the original object. This means 
that if you make further changes to your original ‘wheel’, these aren’t pushed through to the 
simple copies. However, of course, you can delete the copies, make a change to the design, 
and recopy if needed.
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Let’s make copies and lay them out as a set of four. 
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The Next Step
We’re going to 3D-print these wheels, and you could just export one instance of the wheel and 
then duplicate it in the slicer software – but, again, it’s just as easy to do this in FreeCAD. 
Having made the four copies of the wheel, let’s save the work and then, select all 4 wheel. 
Next click ‘file – export’. You can export a mesh file of the wheels ready for slicing for 3D 
printing. Select ‘STL Mesh (*.stl, *.ast)’ as file type to save as and give it a name eg. 
‘4Wheels.stl’.
Having exported the STL file, you could open it in the favoured slicer and 3D-print them. 

Transparency
Selecting items in the file tree makes them become highlighted in the document viewer 
window and, whilst this is useful sometimes, it’s easier to set some component items to be 
different colours and adjust their transparency. This can help us see the internal geometry of 
parts, and can allow us to check internal positions. To do this, highlight a part in the file tree 
view and right-click. Scroll to ‘appearance’. In the menu that appears, you will see that you can 
set the material type and also the shape and line colour, and also set the transparency.
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Using Part Design and Sketcher workbenches

You are going to design a small bird feeder using the 'Part design' and 'Sketcher' workbenches 
using different methods where you will create a 'body' using the 'Part design' and 'Sketcher' 
workbenches. The techniques are a little more complex, but give a much more control over 
designs.

What is a body?
A body is best described as a component part that is one continuous solid object. To visualise 
this, an example could be a nut and a bolt. If you wanted to model a nut and bolt, they would 
both be separate bodies that could then be fastened together as an assembly. The 3D form of 
a nut and a bolt can be modelled as a continuous single piece, and so each can be considered 
a body. In this tutorial, you are using sketches and performing operations on the sketches such 
as 'padding' where you extrude a sketch, and 'pocketing' where you cut the shape of a sketch 
into an existing object. However, you can also add primitive objects on the Part Design 
workbench similar to the use of the part workbench.

Pick your workbench
Opening FreeCAD, start a new document and then select the Part Design workbench from the 
drop-down menu. You should see in the combo view, on the left-hand side, a single option 
which is 'create body' – click this. 

You will then be presented with two options: 'Create sketch' and 'Create boolean'. Click 'Create 
sketch'. You are then presented with a choice of which plane to base the sketch in: XY, XZ, or 
YZ. 
An easy way to visualise the XY plane is by imagining a 3D printer and looking down on it from 
above onto the bed. If sketched onto the printer bed, then working you are working on the XY 
plane. Select the XY plane and click OK. At this point, FreeCAD should automatically switch to 
the Sketcher workbench.
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Next, select the 'Create a polyline' tool icon? 

Draw three connected lines in a U-shape roughly laid out. Starting at the top left-hand side of 
the U, click on the vertical zero-line on the Y-axis at any height and then drag the line down to 
the origin point of the XY plane. 
Conveniently, when hover over either zero-line or any point they will turn yellow. Clicking when 
yellow, will place the drawn object on the highlighted point or line. Next, pull the line out 
horizontally and left-click before pulling it up vertically. Right-click to end the three lines. If you 
have done this correctly, the horizontal line and vertical line will be white, but will have a small 
red horizontal or respectively vertical line. 
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In the combo view panel, you should see a 'Solver messages' tab with a message about 
numerous 'degrees of freedom'. 

The aim is to reduce these degrees of freedom to zero by constraining all the items within a 
sketch. Constraining a sketch is the process of adding constraints that complete all the 
information about a sketch item's positions and dimensions. This is an incredibly useful 
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approach, meaning you can return to sketches at any point in the design and make changes 
that will be automatically recalculated into the whole model. 
The sketcher solver automatically adds some constraints when it guesses, for example, you 
want a line to be vertical or horizontal, as you have just done. 
Starting on a line and including the origin point on the XY plane also means that you don’t 
need to constrain these lines positional co-ordinates, but you do need to constrain the lengths 
of the line. Later you will constrain items that aren’t on these lines, so you’ll see how to set 
positions of items relative to other parts of the design. 

Constraining choices
As you get used to applying constraints, you will realise that there are lots of different ways to 
achieve the same results. To constrain the lines, go to select the two vertical lines. To do this, 
right-click to deactivate the line drawing tool and then left-click on both the vertical lines in 
turn. Next, press the 'Create an equality constraint' tool.

Note: you might need to expand the toolbar by clicking the double right-pointing arrow.

The two lines should now appear as an equal but undefined length. If you left-click on the red 
point at the top of either line and drag it, you should now find that both lines extend together 
as they are constrained as equal. This ability to extend the line is a degree of freedom, and 
sometimes, clicking and dragging items in the sketch can help identify what you need to 
constrain. Left-click to select 'Fix a vertical distance' tool icon

In the dialogue box that appears, type '20 mm', and then click OK. You should now see a red 
constraint label with '20 mm' in the viewer window – both vertical lines are now set to 20 mm. 
If you ever want to change this value, double-click on the constraint in the viewer 
window and the dialog box will reopen. You can click and drag the constraint around in the 
viewer window, and as you add more detail and constraints, you might do this to keep things 
clear.
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Next, select the horizontal line and click the 'Fix a horizontal distance' tool

Set this length to 80 mm. You should now see that the sketch as it stands is fully constrained, 
the solver says there are no degrees of freedom, and that all lines are green.
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A bit sketchy
Click the 'Create an arc' tool icon, but click its drop-down menu and scroll to the 'End points 
and rim point' option.

Hover over the uppermost point of the left-hand vertical line until the point becomes yellow, 
single left-click, and then move across to the top point of the right-hand vertical line and left-
click again – this creates the end points of the arc. Next, move up and towards the centre of 
the two vertical lines to finish the arc roughly in the correct place. To constrain the arc – as the 
end points are already constrained – you just need to set the radius of the arc. Highlight the 
arc line and then click the 'Constrain an arc or a circle' tool icon 

and in the dialog box, set the radius to 40 mm. You should now have a fully constrained 
sketch, with all lines turned green. 
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This sketch is the main outline of the bird feeder, so click 'close' on the sketch solver panel in 
the combo view window, and return to the Part design workbench. Make sure that the sketch 
you drew is highlighted in the file tree, then click the 'Tasks' tab just above the file tree view. 

Click 'Pad', and then type '15 mm' in the dialog box to set the thickness of the pad/extrusion.

For the rest of this project, you are going to create more sketches, but these sketches are 
going to be drawn onto faces of the pad object you have just made. The first job is to make a 
pocket for the bird feed to be contained in. So, left-click in the viewer to select the upper face 
of the object. 

Note: to fit the content on the screen you can zoom in or out holding the Crtl-key and rolling 
the mouse-wheel or click the ‘Fit the whole content on the screen’ button
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Then click the 'Create sketch' tool icon which should now bring you back into the Sketcher 
workbench with the face of the pad you selected in view. 

Click the 'Create a circle' tool icon.

Left-click and drag and left-click again to draw a circle of any size anywhere in the Sketcher 
viewer. Use the 'Constrain an arc or circle' tool you used earlier to set the raduis to 20 mm. 
Exit the tool, pressing the Esc-key.

Next, click to select the centre point of the circle. To position the 20 mm circle, click the 
'Horizontal distance constraint' tool used earlier and set the distance to the midpoint of the 
feeder, which is 40 mm. Next, set the vertical height of the centre point of the circle relative to 
the zero point at 30 mm. This should place it nicely centralised in the feeder design and should 
be fully constrained. 
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Close the sketch, and with this new sketch highlighted in the file tree, click 'Pocket' from the 
list on the 'Tasks' tab. You should now see that it’s cutting the circle as a pocket into the bird 
feeder design. Eet the depth of the pocket to 8 mm.

Quick Tip
You can use the constraint tools in different ways – you can select the sketch item and then 
click the constraint tool, or you can select the tool first and then click the item or items. 
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A sticking point
To attach the bird feeder, create a pocket and a slot which is used to fit some rubber window 
suckers. The arrangement of the slotted pocket could also allow the bird feeder to slot onto a 
couple of small screws. 
In the Part design viewer, rotate the bird feeder and selected the bottom of the design opposite 
to the pocket just created. As before with this selected, click the 'Create a sketch' tool. Next, 
select the 'Create a rectangle' tool icon. Draw two rectangles of any size anywhere in the 
sketcher window. Conveniently the rectangle drawing tool constrains the vertical and horizontal 
lines, so all you have to add is the line lengths and the positions. Make the rectangles 10 mm 
by 6 mm. 

Then use the zero axis point to locate the closest rectangle to it, 8 mm across and 4 mm down 
from the straight edges of the design using the horizontal and vertical distance constraint tools 
and a corner point of the rectangle, as you have done with other items. 
However, to position the other rectangle, use a clever little function. By clicking the 'Create an 
edge linked to an external geometry' tool, you can select and import lines from the underlying 
object which aren’t in this sketch. 

Hover over the 20 mm vertical line at the far edge of the bird feeder and select it, once 
highlighted. This now creates an edge and points at either end to which you can attach objects 
or constraints. This means that instead of calculating the position of the other rectangle from 
the XY zero origin point, you can now constrain this by saying it is 8 mm and 4 mm from the 
opposite corner of the object.
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Having constrained the rectangles sketch, close the sketch and performed another pocket 
operation to a depth of 10 mm. 

Next, cut slots that go into these pockets, so select the face of the back of the bird feeder 
object that need to be sketched on and create a new sketch.
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Finishing off
In this sketch use the 'create a slot in the sketch' too. This tool works similarly to the rectangle 
tool but creates a pill-shaped slot item. 

Similarly again, some of the edges and arcs are partially constrained. You can constrain these 
in multiple ways, but opt to select two opposite points on either side of the slot and constrain 
the horizontal distance between them to 4 mm. Then constrain just one of the vertical lines to 
10 mm as both sides are considered an equality. With a fixed width and height, there is no 
need to constrain the arc, and so position the slot sketches in the correct places to coincide 
with the rectangular pocket. Use the point at the centre of the top end of each slot (the centre 
point of the radial arcs) to position the slots to coincide with the rectangle pockets. This should 
be 13mm from the edge. Remember to use the 'Create an edge linked to an external 
geometry' tool. 
Position top centre point of the slots at 5 mm from the bottom.

Close the sketch and again performed a pocket, setting the depth to 5 mm, to cut into the 
rectangular pocket, but not deeper into the object.
Finally, Added a fillet to the edge of the top of the feeder and the feeder bowl by selecting the 
top face of the feeder and clicking the 'fillet tool' icon and setting the fillet radius to 2 mm. 
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Hopefully, you now have a feel for how sketching and constraints work – the great advantage 
being that, if you want to change a dimension or position at a later date, you can click through 
to find the underlying sketch constraint, edit it, and the whole design relating to that change 
will be updated. It’s a powerful and useful way to work. 

Quick Tip
You have mainly created sketches on the object and pocketed them, but, of course, you can 
create sketches and extrude them just as easily using the 'Pad' tool
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Thickness
For a quick example of using the Thickness’ tool, begin in the Part Design workbench and 
create a new body. Create a new sketch in the body on the XY plane, then select the polygon 
tool to draw a hexagon. Start your hexagon on the 0,0 point of the axis so that it is positionally 
constrained. You should have a hexagon with two degrees of freedom. 
A simple way to constrain a hexagon is to make the uppermost line of the hexagon horizontal 
by selecting the line and clicking the ‘create a horizontal constraint’ tool. Next, you can select 
two nodes vertically above each other, and set a vertical distance to fully constrain the sketch 

Close the sketch and then pad the sketch with 50 mm using the pad dialogue found on the 
tasks tab in the combo view window.
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You are going to now use the thickness tool to hollow out your hexagonal extrusion. Select the 
upper face of the hexagonal extrusion and then click the ‘Thickness’ tool. You should see 
instantly that the part now appears as a hollowed version of itself. Make is 2 mm. 
In the thickness tool dialog, you can see the selected face and change various parameters 

You can, of course, increase and decrease the thickness that is created. By default, the 
thickness dialog adds the thickness to the outside of the underlying geometry, so if you set the 
hexagon vertical constraint to 60 mm you now will have an object that is 62 mm (60 mm + 2 
mm thicknesses). If you want to create an object that matches the external dimensions of the 
underlying geometry, click the ‘Make thickness inwards’ box. You can also swap between Arc 
and Intersection, which essentially toggles between creating filleted edges or sharp edges on 
the thickness. 
Finally, if you want to apply a thickness but create an object which is more of a pipe than a 
bowl, you can click the ‘Add Face’ button. In the preview window, the original selected face 
reappears highlighted and you can select the opposite face. You should now have a hexagonal 
object with a wall thickness with both ends open. 

Other options
The thickness tool is an excellent way to quickly create hollow geometries, but it does have 
some limitations. It can fail to work with more complex shapes. Things like curvy cones can be 
its nemesis. Later on we’ll look at ‘Lofting’ tools, which enable us to create hollow parts with 
curved walls and more. 
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Let’s get parametric!

You looked at making multiple ’simple copies’ of parts using the ‘part’ menu on the part 
workbench. You can also use that approach to create simple copies of bodies that you have 
designed in Part Design. Sometimes you might want to make multiple similar parts, but with 
one or more dimensions changed – for example, if you were drawing a model of a 3D printer 
that used the common 2020 aluminium extrusion.

One way you could make this easier is to draw an aluminium extrusion profile sketch, and then 
pad or extrude it multiple times to multiple lengths. As a workflow, you might choose to use 
the Part Design workbench to create a body for your original extrusion and then create 
multiple simple copies on the part workbench.
This is a very simple example that introduces the idea of working parametrically. Parametric 
work in CAD is where you can change the model geometry by adjusting parameters such as 
dimensions. Whilst only being one parameter, you can use this mini project to learn about 
using a spreadsheet to store and alter parameters for objects and sketches.

you are going to work with a simple design for a tube and created a new project. On the Part 
Design workbench you select to create a new body and then to create a sketch in the XY plane. 
you drew a shape of circle, put a constraint on it of 20 mm.
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Having constrained the sketch, you now pad it to 50 mm, make an inner tichnes of 3 mm and 
remove the bottom. 

you could now, of course, just set a pad length of extrusion and then create a simple copy on 
the part workbench to create different length parts, but you want to learn how to use the 
spreadsheet function to further explore parametric work.
Let's move to the spreadsheet workbench using the workbench drop-down menu, and click the 
‘create a new spreadsheet’ icon. 

You should now see a spreadsheet open in the preview window in a separate tab. 
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This is very handy, as it allows quick switching between the model and the spreadsheet. If you 
close the spreadsheet tab, the spreadsheet is still an item in the file tree view and you can 
double-click to open it. The spreadsheet functions are very capable, and similar to standard 
spreadsheets you may have used in office software. For this simple task, you are going to write 
the label ‘Length’ in cell A1, and then in cell B1 you can type a length you want your extrusion 
to be. When you type a dimension into a constraint in the sketcher, it interprets that number 
as the units you use throughout FreeCAD, which can be set in the preferences menu. In your 
case, this is millimetres and will be the case for your spreadsheet values, so you don’t need to 
define your input units in the spreadsheet. Set cell B1 to 100

Click back onto the preview tab with the model in it. Reopen the pad by double-clicking on the 
pad in the file tree. In the input box for ‘length’ you should see the current pad length value, 
but you should also see a blue circle icon on the right-hand side of the box . Click this to open 
the formula editor. 
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In this input box, now start to type ‘Spreadsheet’. You should find that it automatically 
suggests the word spreadsheet as you start typing. Click the suggested ‘Spreadsheet’ from the 
drop-down and it should insert the word spreadsheet followed by a full stop. After the full stop, 
you need to input the cell location of the cell from which you want it to take its value. If you 
type ‘B’, it again should automatically suggest ‘B1’ as a value. This autosuggestion is useful 
when you come to projects with numerous cells of data in a spreadsheet, as it will only suggest 
cells that have data in them. Click the ‘B1’ so that the value in the formula editor reads 
‘Spreadsheet.B1’.

Returning to the preview tab with the model in, you should see that the extrusion body is now 
padded or extruded to the 100 mm length. You can now create multiple simple copies from the 
body using the ‘create a simple copy’ tool in the ‘part’ drop-down on the Part Workbench, 
changing the length of the original body copy in the spreadsheet.

So now, you can change the length in the spreadsheet so the length of the (original) tube 
changes and then create a copy of it to have a new tube. 
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Let's combine your new skills!
Having explored using both spreadsheets and the thickness tool, let’s combine your new skills 
and create an automatic parametric box generator. This simple project makes it easy to create 
a box and lid of any size that you could 3D-print or CNC-machine. 
Let’s begin by creating a new project. In the new project, go to the spreadsheet workbench 
and create a new spreadsheet. For the main body of your box, you are going to need four 
parameters: the box-length (40.00), box-width (45.00), box-height (50.00), and the box- 
thickness (2.00). Create labels for these parameters in cells, and in adjacent cells input some 
initial values: 40, 45, 50, 2

Next, jump to the Part Design workbench and create a body and a sketch in the XY plane. you 
are going to draw a rectangle around the zero point and then, at first, constrain it to always be 
centred around the origin point of the sketch. Draw the rectangle and then click the ‘create a 
symmetry’ constraint tool. Use the symmetry constraint tool to select the upper right-hand 
node, the vertical Y axis line and the upper left-hand node. Repeat this for the upper right, he 
X axis line and lower right nodes. Now the rectangle should always be centred around the 0,0 
co-ordinates, regardless of its size. 
Next, let’s add a constraint for the box length by selecting the top line and clicking the ‘Fix the 
horizontal distance’ tool. In the input box, click the blue circle formula editor button and insert 
‘Spreadsheet’, followed by the cell location for the box length, which in your case was B1. 
Repeat this for the vertical line to set the box width, B2, and the sketch should now appear 
fully constrained.
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Close the sketch and perform a ‘pad’ task to extrude the box; set the pad dimension to receive 
the input from the box height cell, B3, in the spreadsheet. Next, you will click the upper 
surface of your box and use the thickness tool you explored earlier to hollow out your box. To 
set the thickness, you are going to link the thickness value in your spreadsheet, B4. you make 
it an outwards thickness. All being well, you should now have a hollow box in the preview 
window.

To make a lid, you are going to do the same process as you did to make the box section, but 
you are going to use some simple formulae so that the lid is generated to fit whatever 
dimensions are of the box created. 

So go the the spreadsheet and add the lid length,width and height. But first all the clearance, 
being the space between the lid-edge and the box-edge to easy putting the lid on the box. 
Make that clearance 0.5 mm. So the length of the lid becomes now the length of the box + 
twice the thickness of the box + twice the clearance: =B1 + 2 * B4 + 2 * B5. Do identical for 
the width becoming = B2 + 2 * B4 + 2 * B5. The lid height can be any length, I choose 12. 
Thickness is the same as the bow: = B4
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On the Part Design workbench, click to create a new sketch on the XY plane. You don’t need to 
import any geometry from your first sketch, but let’s draw another rectangle and place it along 
the x axis so it isn’t on top of your box base. To positionally constrain this lid rectangle, select 
the upper left corner node and the sketch origin point at 0,0 and set a horizontal distance 
constraint. For the value of this constraint, you have linked the spreadsheet cell that holds the 
box length value, B1. This means that the lid will always be away from the box with a gap in 
between them.
Next, create a symmetry constraint against the x axis line. Now add constraints for length and 
width based on the spreadsheet values for length D1 and width, D2.

Now pad the lid and add tickness outwards. 
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You constrained the length and width of the lid sketch by adding constraints linked to your 
calculated dimensions in the spreadsheet. You then performed a pad using the lid_depth value 
and, in turn, applied a thickness to the lid using the thickness value in the spreadsheet. You 
now have an automatic box generator at your disposal! Simply change the parameters in the 
spreadsheet and it will automatically generate your box with a fitting lid. 

Lining up
Once you have your box generator set up, you can generate boxes of any dimensions easily. 
The layout on the XY plane means that the box and lid will be easy to export and 3D-print, as 
both parts are modelled in a way that emulates them sitting on the print bed. If you wanted to 
look at your box with the lid in position, again you could create a simple copy on the part 
workbench and move and rotate those parts into the correct position. 
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Curving all the way

First up is the Additive Loft function, which is a method that creates straight or curved 
transitions between sketches. It’s a great way of creating complex flowing shapes. To start 
with, you will make a nonsense object just to see how it works, and then you will create a 
small ornamental bowl that can be 3D-printed.
On the Part Design workbench, create a new body and then create a new sketch on the XY 
plane. This should move you onto the sketcher workbench. Select the rectangle tool and draw 
a rectangle in this sketch. As this is a test, you don’t need to add constraints, so close this 
sketch now. 

In the Part Design workbench again, within the same body, create a second sketch. Click the 
'Create sketch' button, and select the XY plane for your second sketch. In this second sketch, 
use the regular polygon tool to draw a hexagon that is smaller than the rectangle you drew – 
draw it inside the rectangle, and don’t worry if it overlaps a little. Again, you don’t need to 
constrain the hexagon, so close the sketch. 
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The next step is to move the hexagon sketch away from the rectangle sketch in the Z-axis. 
As both of the sketches are part of the same body, you can’t move the basic position of the 
hexagon sketch, but you can move the relative attachment point of the sketch. With the sketch 
containing the hexagon selected, you should see the dialogue box for the sketch in the combo 
view panel. In this dialogue box, there are three sections of values separated under the 
headings 'Attachment', 'Base', and 'Sketch'. 
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Making sure you are in the Attachment section, click the Attachment menu, and then click to 
expand the Position menu. In this drop-down menu, adjust the Z-axis to raise the hexagon 
sketch over the rectangle. This can be any amount, but I went for 20 mm. If you are in an 
isometric view in the Part Design workbench, you should see the hexagon sketch rise above 
the rectangle sketch. 

Next, select the original rectangle sketch in the file tree view, and then click the yellow and red 
'loft a selected profile through other profile sections' tool. 

In the combo view panel, you should now see a window – click the 'Add section' button. Having 
clicked that, select the hexagon sketch in the preview window. As you do this, you should see 
a preview of the lofted part connected between the rectangle and the hexagon. 
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There are a couple of checkboxes you can click: one is called 'closed' which will close the ends 
of the lofted object, and the other is 'ruled surface'. Clicking 'ruled surface' toggles the lofted 
object between having either straight line/plane geometries or curved. It is not that obvious a 
difference with your simple example, but you will use this in your next lofting project.
To finish, click the 'closed' checkbox and then OK to perform the loft. In the preview window, 
you will now see the resulting object. 
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Lofted objects are like any other in that you can use other tools on the objects created with 
them, such as selecting edges for fillets. However, when the surfaces generated become 
complex and curved, you might find that some tools don't work and you need a different 
approach. 

One thing people often try with the lofting tool is to apply a thickness to the resulting object to 
hollow it out. Sadly the thickness tools only work on simple geometries, so it’s not possible to 
work this way. However, let’s make a more interesting lofted object and show how you can 
create curved objects with defined thickness walls. 

In a new project, create a body and create a sketch in the XY plane. Draw two circles 
constrained around the origin point and make one slightly smaller than the other; the distance 
between them will create the wall thickness of your object. You made your sketch with the 
outer circle having a diameter of 25 mm and the inner circle having a diameter of 22 mm, to 
give a wall thickness of 1.5 mm
Close the sketch and then create another sketch in the XY plane. Create a larger pair of circles, 
but with the same wall thickness – you went for 45 mm and 42 mm. 
Close this sketch and then create a third sketch with a pair of circles constrained to match the 
first set you drew.

Quick tip : When you are drawing the third sketch, the circles will appear exactly on top of the 
firstsketch. To make it easier, make the original sketch invisible by highlighting it in the file 
tree, toggling visibility by pressing the space bar. 

With the second sketch highlighted, move these circles up the Z-axis using the same method 
you used earlier with your hexagon. Move it up by 25 mm. Next, do the same with the third 
sketch, moving it up the Z-axis 60 mm. 
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Create the loft in a similar way to the earlier example, starting by selecting the first sketch and 
then adding the second sketch and the third sketch in that order. If you uncheck the ruled 
option and the closed option, you should end up with a nice curvy shape.

Sweeping along a path is a similar idea to revolving a sketch and also shares some attributes 
of lofting. However, sweeping uses a user-drawn path or geometry that the extrusion is swept 
along, rather than an automatically generated one. There are a couple of approaches to 
sweeping in FreeCAD: one using the part workbench, the other using the Part Design 
workbench. Let's look at both to have both methods in your skill set. 
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Curving in Part Design 
Starting on the Part Design workbench, create a new project, create a body, and create a 
sketch in the XY plane. In the blank sketch, make a small closed shape around the origin point. 
You drew a square and then added some fillets in the corners by clicking the 'create a fillet 
between two lines or at a coincident point' tool. 

With the fillet tool selected, click on some corners of the square to add some fillets, and resize 
them to make an interesting shape. This shape will be the profile of your item you extrude by 
sweeping it along a path. Again, constraining the sketch is unimportant for a simple 
exploration of the tool.
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Close the sketch and then create a new empty sketch in the body. Create this new sketch in 
the XZ plane. In this sketch, you are going to create the path along which your first sketch 
profile will be swept. Let's use 'create a B-spline in the sketch' tool. 

This tool allows us to create a combination of curves in a single line. With the B-spline tool 
selected, left-click over the origin point in the sketch and pull a line up and to the right or left 
of vertical, then left-click again and continue with the next line upwards and back towards the 
centre line. Left-click again and move back out to the right and upwards to create a skewed 
kind of Z-shape. Left-click to set the next point, and then right-click to finish the B-spline. The 
two lines you drew should now become curved, and you should see some blue circles. Simply, 
for now, moving the circles allows you to adjust the curve of the lines. Make a nice swooping 
curve, such as the one I created.
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Close the sketch, and in the preview window, you can rotate your view a little and see that the 
curved edge you created starts at the origin point, which is in the middle of your profile sketch.

To sweep the profile along the curved path, highlight the first sketch you made and then click 
the yellow and red 'sweep a selected sketch along a path' tool. 

You should see a dialogue box appear in the combo view panel. In the dialogue box, you need 
to select the path or object along which to sweep. You can do this in a couple of ways. You can 
either click the 'Object' button under the 'path to sweep along', or you can click the 'Add 
Edges' button. Having clicked either of these buttons, you can then select the curved path in 
the preview window. You should now see a brown preview of the profile swept along your path. 
Click 'OK' to finish the sweep. You should now have a nice swept object in the preview window.
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There are many other options in the sweep utility in the Part Design workbench that can 
change the way that corners are handled in a swept object, and also how it handles 
transforming from one profile to another profile over the course of a sweep, which you will 
explore on the part workbench shortly. The other thing of note on the Part Design workbench is 
that there is a blue and red icon that is the same as the sweep tool you used, except that it's 
for subtractive sweeps. 

This means you could draw a solid object and then cut out and remove a swept path through 
it.

Quick Tip: The Part Design workbench sweep tool creates single solid body objects, but you 
can apply some techniques you learnt, where you used the 'Create a thickness tool'. As a 
quick recap, select the face of one end of your swept solid object and click the thickness tool. 
In the dialogue box, you can set the thickness of the wall structure, and to make it a pipe 
object open at both ends, click 'Add face' and then additionally select the opposite end of the 
swept object. 

Page 46 of 212



Curving in Part
Finally, let’s look at the sweep utilities on the Part workbench, which are laid out a little 
differently. You will also create two profiles and a path, and the profile will be transformed from 
one shape to the other along the path. Let's create a new project in Part Design workbench , 
create a new body. Create a new sketch in the XY plane and then draw a circle anchored 
around the origin point. It is up to you if you want to constrain it or not for this example. Close 
that sketch and then create a second sketch, again in the XY plane. In this sketch, let's draw a 
square around the origin point which should be a similar size to the circle you drew in the first 
sketch. Close this sketch, but highlight it in the combo view panel so that the dialogue box 
options for the sketch appear below it. You are going to move the position of the sketch so that 
it shifts vertically 70 mm up the Z-axis. In the sketch dialogue box under the 'Attachment' 
heading, open the drop-down menu labelled 'Attachment' then, in turn, open the drop-down 
menu labelled 'Position'. In this menu, change the Z-axis value to 70 mm.
You should be able to see in the preview window that the square is now above the circle. 

Next, making sure nothing is selected in the file tree, add a third sketch with this sketch drawn 
on the XZ plane. Using the 'create an edge linked to an external geometry' tool, 

click the horizontal line that is on the upper square sketch. Next, use the B-spline tool to 
create a nice curved line which starts at the origin point and curves up to reach the centre of 
the upper square sketch. 
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Then close the sketch, and you should have three sketches roughly similar to this.
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Moving to the part workbench, click the 'utility to sweep' tool. 

In the dialogue box, you should see the list of sketches on the left-hand side. In turn, select 
the first sketch containing the circle, and click the right-facing arrow that becomes highlighted 
to move the sketch into the 'selected profiles' column. Repeat this for the second sketch – 
the sketch that contains the square. Next, click the 'Sweep path' button, and the dialogue box 
will become greyed out. Click the path you want to sweep along in the preview window to turn 
it green, and then click the curved path you created earlier. Next, click 'Done' and then click the 
'OK' button. You should now see the circle profile has been swept towards the square on your 
curved path, and it has transformed throughout the curve to conform to the square profile. 

In the file tree, this is now a 'sweep' object, and double-clicking the sweep object doesn’t allow 
you to edit the sweep, but rather, opens the dialogue box to move and rotate the part. If you 
want to change any sweep parameters, you must select the sweep object and delete it, which 
will return you to just having the three separate sketches, and then repeat the sweep utility 
process. In the dialogue box for the sweep utility, you can select to make the object a solid. 
Then, you could create a simple copy and then use the thickness and other tools and utilities. 
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Technical drawings

Many users will be using FreeCAD to model in 3D to produce files that can be sliced and 
printed on a 3D printer. Other users, however, will be perhaps designing parts that they want 
to create using subtractive methods, like lathes or milling machines. Some will be using bench-
fitting techniques to cut, drill, and file to hew parts from materials. To share the information 
needed to manufacture a part, the standard practice is to use technical drawings. 
Drafting a technical drawing using pencil and paper and a drawing board is a fantastic skill to 
have, but it can be difficult to master. FreeCAD simplifies the creation of technical drawings 
from 3D models by having a dedicated technical drawing workbench called ‘TechDraw’.

To work through an example of creating a technical drawing, you need a 3D model to use. Let’s 
quickly draw an item using simple techniques you learnt using the Part Design workbench.
Create a new project and, on the ‘Part Design’ workbench, create a body and then a sketch in 
the XY plane. Using the ‘Create Polyline’ tool, create a shape similar as below. 

You don’t necessarily need to constrain the entire model or sketch to use the TechDraw tools, 
but it’s useful, in this case, to have all the dimensions constrained so you can compare the 
dimensions on the drawing (more on why that’s important later).

Having drawn the outline, add a circle in the object, and then close the sketch and perform a 
pad operation of 10 mm on the sketch to create your part. Finally, before you jump into the 
TechDraw workbench, add a fillet to an external edge with a 7 mm radius. 
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Having an internal hole and an external radius and an angled edge gives us enough details to 
do a good demonstration of the TechDraw workbench tools.
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Getting Set Up
Before you add any views to your new page, you need to make an important change in some 
preferences so that the centres of circles and arcs are marked when they are drawn in 
TechDraw views. Making sure you are on the TechDraw workbench, go to Edit > Preferences 
and then scroll down the left-hand side to the TechDraw icon. On the TechDraw preferences 
window, click the ‘Annotation’ tab and make sure the ‘Show centre marks’ and ‘Print centre 
marks’ boxes are checked. Click Apply, and then OK to close Preferences.
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Making a techinal drawing
To begin playing with TechDraw, select the TechDraw workbench from the drop-down menu. 
Click the ‘Insert Default Page’ tool icon and you should have a new tab in the preview window 
with an empty technical drawing page in it.

You can see that the new ‘page’ is listed as an object in the file tree. 

Switch back to the tab that contains the 3D model and you’ll notice that, despite switching 
tabs, you are still in the TechDraw workbench. As an experiment, move the model so that it is 
at an angle rather than in one of the ‘front, top, back’ type views. Next, ensuring the body is 
highlighted in the file tree, click the ‘Insert a View’ tool icon. 

If you switch to the ‘page’ tab, you should see the 3D object has been added to the drawing in 
its exact view, at the angle it appears on the live preview. 
It’s important you know that it does this, because if your object is slightly at an angle, you 
might not notice, but it can affect dimensions in technical drawings added later. On the ‘page’ 
tab, you should have a dashed line around the ‘view’ – these are referred to as the ‘View 
Frames’. Clicking the frame and dragging allows you to move the view around the technical 
drawing page. Highlighting the frame and clicking delete allows you to remove it. Click and 
delete this angled view and let’s have another go. Return to the preview window and, using 
either the view icons, or the rotation block, select the ‘top’ view. Repeat the process of clicking 
the ‘Insert a View’ tool to add the view to the page. 
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You’ll notice that all the lines in the drawing have the vertices marked as dots (similar to the 
Sketcher layout). The vertices help us to add dimensions and other tasks, but they are part of 
the view frame. You can toggle the view frames on and off by clicking the ‘Turn View Frames 
On/Off’ icon, or by right-clicking and selecting ‘Toggle Frames’. 

Your simple test piece design doesn’t need masses of views to be able to show all of its 
attributes and dimensions, but you would definitely need another view adding to show the 
thickness of the part. Later, you will look at automatically generating multiple views of a part 
which adhere to technical drawing. Do this manually as you did with your top view. Return to 
the 3D model preview, and move the model so you are in a left- or right-hand view, then click 
the ‘Insert View’ button. 
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Next, let’s add some dimensions to parts of the views so that someone could make this part 
accurately. It’s similar in feel to adding constraints in the Sketcher workbench. First, let’s select 
the long line/edge at the base of your object in the front view on the technical drawing page. 
Then click the yellow ‘Insert Horizontal Dimension’ tool icon. 

You should now see a dimension appear in the drawing. Similar to the Sketcher workbench, 
you can click and drag this dimension to different areas to organise where the labels are. 

Adding the height of the 3D object is a similar task, except you don’t have a single complete 
line from the bottom to the top of the object, so you will use vertices instead. Similar to the 
vertical and horizontal constraints in the Sketcher workbench, TechDraw can create a vertical 
dimension between two points, even if they don’t sit on the same edge. 
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Slightly differently than the Sketcher workbench, when you want to select multiple vertices, 
you need to hold the CTRL key down. Select the right-hand vertex on the bottom edge of your 
object and the highest vertex on the right of the small bit that sticks up at the top of the 
design. Click the ‘Insert Vertical Dimension’ tool to add the dimension and note that it correctly 
adds the vertical distance between the points – not the distance along a straight line between 
the points.

Holes in designs in technical drawings are commonly annotated with the diameter rather than 
the radius, often as the maker will be wanting to know what size drill or reamer to use. Adding 
a dimension for the diameter of your hole is similar to adding a radius constraint when you 
drew the circle in Sketcher. You simply select the circle and then click the yellow ‘Insert 
Diameter Dimension’ and the diameter of your hole is displayed. 

To indicate the co-ordinate position of the hole centre, you can select the centre mark and 
apply horizontal and vertical dimensions relative to another vertex. You have selected the 
lower left-hand corner of the object to act as this datum point and, of course, you could repeat 
this for the centre marks of the arc of the fillet. Most technical drawings would have a radius of 
the arc marked, rather than a diameter, and this would apply to your fillet arc. To add this, 
simply click the arc line and then click the ‘Insert Radius Dimension’ tool

To add a dimension showing the angle of the left-hand side line, relative to the base of the 
object, select both these lines and click the yellow ‘Insert Angle Dimension’ tool icon. Whilst it’s 
not often necessary, sometimes you might want to add the actual length of a line rather than a 
vertical or horizontal and, to do this, let’s select the angled line and click the yellow ‘Insert 
Length Dimension’ tool. 

This is a very useful function at times, but also it hints at the way TechDraw handles line/edge 
length and a possible problem. If you return to your 3D object in the live preview, click the ‘Set 
to Isometric View’ icon from the collection of blue view icon tools. 

With the object now at an angled isometric view, let’s add a new view to your TechDraw page. 
Move to the technical drawing page and move the new view so that it’s clear of other views. 
Select one of the long lines that is the base of your object and click the ‘Insert Length 
Dimension’ tool. If you compare the dimension you have just added to the very first horizontal 
dimension you added on your first view of the object, you’ll notice that they are different. This 
is 
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because the TechDraw dimensions default to being based off the view drawing rather than the 
actual 3D object, so the actual length of the angled line in the isometric view drawing is 
shorter.
If you wanted to add an isometric view with some dimensions added, you can overcome this 
problem by linking a dimension to the 3D object. First, highlight the incorrect dimension you 
just added to the isometric view, and look in the file tree view to identify the name of this 
dimension. In your example, this was ‘Dimension012’. 

Having noted that, click over to the 3D object tab and highlight the same edge on the 3D 
object. Next, click the yellow ‘Link Dimension to 3D Geometry’ tool. 
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In the combo view, you will see a window with a list of dimensions in a left-hand column. 
Select the dimension name that you noted earlier and then click the right-facing arrow to bring 
that dimension name over to the right-hand column. 

Click OK at the top of the menu and return to the technical drawing page tab. 
You should now see that the dimension has updated to the correct length of the 3D object.

Note: if it did not update right-away, click on the Dimension-line in the tree-view. 
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All-over again but better and faster
Having played with the TechDraw tools a little, let’s delete your practice drawing and start 
again, looking at a couple of things that might make the process quicker now you know how 
some of the tools work. 
Select the page you were working on in the file tree and delete it. To create a new page for 
your technical drawing, let’s click a different icon: the ‘Insert Page Using Template’ icon that 
looks like an orange folder. 

This opens a folder containing different templates for technical drawings. 

There are some things that will appear obvious to you, like there are different page sizes: A4, 
A3, A1, etc. There are also some templates that adhere to particular technical standards, such 
as the American National Standards Institute (ANSI) and the International Organisation for 
Standardisation (ISO), which may be of use if you want to make standard-compliant drawings. 
Let’s use a page called ‘A3_LandscapeTD.svg’.
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Make sure that the 3D object is in the top view in the preview and highlight the body in the file 
tree. This time, instead of clicking to insert a single view, let’s use the ‘Insert Multiple Linked 
Views Of Drawable Objects’ tool icon, which should be next to the template folder icon. 

If you now click to the ‘page’ tab, you can see any changes you make in the dialog box live on 
the template.

In the dialog box, the first thing you will see is a projection menu. Let’s use first angle, as your 
template indicates the drawing will be in first angle projection. 
For this example, you don’t need to scale the drawings as it’s quite a small object. However, 
you can play with selecting a custom scale and changing the values, which is useful if you want 
to scale down a large object on the plans. Further down you will see an arrangement of 
checkboxes that correspond with the multiple views that will be added to your drawing. 
Select the pattern you have selected and click OK. On the technical drawing, you should now 
have the corresponding views automatically inserted. 

Page 60 of 212



To move linked views is slightly different as it always aligns the projection of the main views to 
the centre view. To move all the views as a group, move the centre view; to move the upper, 
lower, and side views, you can push and pull them relative to the centre view. The exception is 
your isometric view, which you can move anywhere in the page.
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Annotations
Most technical drawings will have some details added as text. In your default template, you 
have some text boxes set up in the lower right-hand corner. These include common details you 
might wish to add to a technical drawing, including the title, designer name, date, scale of the 
drawing, and more. With the view frames turned on, you should notice that each text area has 
a small green block. Clicking on the green block allows you to edit and insert the text that you 
want to add. You’ll also notice that there are some blank boxes with no text inserted. You can 
add text anywhere on the document by using the ‘Insert Annotation’ tool. 

Clicking the tool, you should see a view frame appear labelled ‘annotation’ with ‘default text’ 
written in it. 

To edit the annotation, select it in the file tree view. In the combo view, you should now see 
the editable parameters of the annotation, which include common text editing options like font 
and size. At the top of the annotation parameters, you should see ‘Text’ and the ‘Default Text’ 
that is stored within it. Click the ellipsis icon (the three dots to the right) and in the pop-up 
window you can input text. 
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Note that it doesn’t use text wrapping, and you need to hit your keyboard Enter-key to create 
a new line of text. In the image above, you have filled in the default drawing details with the 
editable text boxes, but also added some text in an annotation box outside the default drawing 
text boxes, as you can add an annotation frame anywhere in the drawing.

Note: To move any object in the TechDraw, also annotations, turn View Frames on and you can 
drag the desired object with the mouse.
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Getting centred
Technical drawings often use centre lines and hatching and other effects to make them 
more readable. Adding a patterned centre line is possible, and you can use a face, two 
vertices, or two lines as a reference. As a quick example, click the face of your object in 
the front view to select it and then click the ‘Insert Centre Line’ tool icon. 

In the dialog box you can adjust the position and appearance, but for now just click OK and a 
dashed line should appear vertically through your object. 

A centre line is classed as a ‘cosmetic object’ and as such doesn’t appear in the file tree. To 
remove the centre line you just created, you need to select the centre line and then click the 
‘Remove Cosmetic Object’ icon, which looks like an eraser. 
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To add hatching to a face, select the face and then click the ‘Apply Geometric Hatch To Face’. In 
the dialog you can change various settings such as the pattern, line weight, and colour.

Quick Tip: To export and print your technical drawing at any time, simply right-click anywhere 
in the drawing 

As ever with FreeCAD, there’s heaps more you could look at on this workbench alone, but 
hopefully you are well on the path to creating beautiful and useful technical drawings for all 
your project needs. 

Extra Information on Angles

Technical drawing in itself is a massive field to learn about, and there are numerous standards 
and systems in place governing technical drawings. One set of standards relate to the 
projection angles which affect where views are positioned in a technical drawing. These two 
projection views families, ‘First Angle’ and ‘Third Angle’, are both used but create a technical 
drawing laid out differently. 
First angle drawings are more common outside of North America, whereas in North America 
third angle is more common. It’s important that you indicate that you are using a first or third 
angle projection on a technical drawing and that you only use that type of view and don’t mix 
them. Commonly on technical drawings, you indicate whether a drawing is first or third angle 
by adding the correct icon, as seen in the image below.
It’s quite complex to explain the difference, and there are numerous different approaches to 
explaining first and third angle. A good place to start is this Wikipedia page: 
https://en.wikipedia.org/wiki/Multiview_projection#Third-angle_projection
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Add-on workbenches and Laser Cut Interlocking

After looking at how you install additional workbenches, you will focus on using an excellent 
workbench called ’Laser Cut Interlocking’ or ’LCInterlocking’, which offers some interesting 
and useful tools for those working on designs destined for a laser cutter or CNC router. 

To explore the amazing array of add-on workbenches, you’ll need to be connected to 
the internet. You can view the available add-on workbenches from any workbench in FreeCAD 
by simply clicking Tools > Addon Manager. 
The Addon Manager will then check all the available add-on workbenches – it may take a few 
seconds for the list to appear as it checks it’s up to date. You should end up with a list that 
looks like this. 

Before you install the workbench we’ll be using, scroll around the list. If you highlight a 
workbench on the list, information about it will appear on the right-hand side of the window. 
It’s incredible what workbenches there are! Like all of FreeCAD, the add-on workbenches listed 
in the Addon Manager represent many thousands of hours of voluntary contributions by 
FreeCAD community developers, covering a vast array of subjects and interests. 
From aeroplane design tools to computational fluid dynamics to 3D print slicing engines – 
there’s a lot to explore. 

Installing a workbench is as simple as selecting it in the list and then clicking Install. Behind 
the scenes, FreeCAD connects to the workbench code repository online and downloads and 
installs the latest version. It’s then simple to update a workbench when new features are 
released. It’s just a case of clicking ’Install/update selected’ on the relevant workbench in the 
Addon Manager. 
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The workbench you are going to look at is called ’LCInterlocking’ – it’s described as the 
’FreeCAD Laser Cut Interlocking Module’. Go ahead and click install. Once installed, the Addon 
Manager will prompt you to close and restart FreeCAD to finish the installation. Once FreeCAD 
has restarted, let’s create a small project to explore the tools on this new workbench.

The LCInterlocking workbench has tools that allow a collection of parts in FreeCAD to be pulled 
apart and laid out flat. It then has tools that enable us to create a two-dimensional projection 
of the part shapes that you can export in various file formats (DXF, SVG, etc.). While it’s 
predominantly, as the name suggests, aimed at laser cutting, it also can be useful for other 
processes, such as preparing files and objects to set up toolpaths for CNC routing. 

The ’interlocking’ part of the LCInterlocking name hints at another handy feature: the 
workbench has tools that can automatically create tabbed joints in objects where one part has 
tabs and the other part has receiving slots.
To explore these tools, let’s create a collection of parts that form the base and sides of a 
simple box. In the Sketcher workbench, draw a sketch in the XY plane of a square that is 100 
mm on each side, and let’s constrain it with the lower-left corner onto the 0,0 point of the axis.

Having drawn the square sketch, use the ’extrude/pad’ tool on the Part workbench to extrude 
the sketch to a thickness of 3 mm. Using 3 mm means you can imagine you are going to laser-
cut your tabbed box out of 3 mm plastic or plywood. 
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You could make this base part in a much easier way – namely, you could use the ’Create a 
cube solid’ tool. However, as an example, you wanted one part to be made from an extrusion 
as you need to treat extruded parts a little differently when you get to the LCInterlocking 
workbench. 

You can use the cube generator to create the sides of your box, however. First, let’s make a 
cube by clicking the ’Create a cube solid’ tool. 

Double-click the object in the Combo View file tree and then change its dimensional 
parameters. Let’s make the length 100 mm, height 97 mm, and width 3 mm. 
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Next, let’s right-click this cube in the file tree and then select Transform – use the arrows in 
the preview window to bring the side up on the Z-axis by 3 mm so that it sits exactly on top of 
the base you made earlier.

Make the opposite side of your box by either repeating the process and moving it to the 
opposite side, or simply copy and paste and move a duplicate of the first side. 
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Next, repeat the process to make the final two sides of the simple box, making the height 97 
mm, width 94 mm, and length 3 mm. Move these in a similar way using the ’Transform’ tool to 
move these sides into the correct positions lined up with the edges of (and sat on) the base.

Before you move over to the LCInterlocking workbench, you need to convert the base into a 
simple part. LCInterlocking prefers to work with parts that are simple objects rather than parts 
that appear as a stack of operations in the file tree view. You could just draw the base with a 
cube, but if you’re working with more complex shapes, this might help you remember to 
convert parts into simple copies before opening the LCInterlocking workbench. So, before 
proceeding, highlight the base part in the file tree, and click Part > Create a Copy > Create a 
Simple Copy. Delete the original extrusion and sketch in the file tree to keep things simple and 
clutter-free. It’s a good idea to right-click on the simple copy of the base and rename it to 
something recognisable, such as ’Base’.
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Next, let’s move to the LCInterlocking workbench by selecting it from the drop-down menu. 
The first task in the new workbench is to create some tabs and slots to ensure strong joints in 
the box. 
To get started, highlight the five parts that form your open box in the file tree, and then click 
the grey ’Interlocking’ tool icon. 

In the dialog box that appears, you will see a button that says ’Add parts’. 
Click this button and you will see the five selected parts appear in the window. 

This list of parts in the dialog box is similar to the file tree in the combo view in that you can 
highlight anything in the list – you can press the SPACE bar to toggle visibility. This is very 
handy for the next task. You need to tell the ’Interlocking’ tool which faces of your box are 
going to interlock. Let’s begin with the faces that will form the tabs that extend into the base. 
Select the ’Base’ part and then press the SPACE bar to make it disappear – do this for three of 
the sides. 

Next, select one of the thin faces on the remaining side of the box, making sure it is the face 
that is touching the base when the base is visible. With that face highlighted, click the ’Add 
faces’ button in the dialog. You should see the added face highlighted in the list, filed under the 
part that it is attached to. 
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If you look down in the dialog box, you will see a menu relating to that face. 
In this, you can input the details of the tabs that you wish to generate on this face.
Add the number of tabs – you can make your own choices, but you went with four. You set the 
’width of tabs’ to 10 mm, ’shift’ was left at 0.00, and the ’interval ratio’ was set to 1.00. You’ll 
see there’s a couple of checkbox items: ’Dog bone hole’ and ’Tab dog bone hole’. 

‘Dog bone holes’ are a method often used in parts that are CNC routed to get rid of a problem 
created by the fact that most router tools are round. If you send a round end mill cutter along 
a path to cut a 90-degree internal corner, you are left with the radius of the tool in the corner 
of the cut. If you are cutting tabs into material in this way, then the tabs won’t fully seat into 
the slots due to this excess material. Dog bone holes are where the machine is instructed to 
cut a little further into the corners on both axes; this slight overcut creates two small, round 
cuts in a corner that look like a stereotypical dog’s bone, giving the process its unusual name. 
You deselected both of the checkboxes as you don’t need them for this example.

Having input the tab parameters, go back up to the top of the interlocking dialog box and click 
the ’Preview’ button. This will launch a new tab in the preview window, and you should see 
that your box appears regardless of which parts are visible or invisible in your other tab. If you 
look at the joint between the base and your tabbed face, there are now four tabs interlocking 
into the base. 
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You can now repeat the above process of selecting and adding faces to the interlocking dialog 
and configuring tabs. Working your way through the model, you added tabs to the other three 
faces that interlock with the base, and then added tabs to two of the side panels to create 
tabbed joints on every interface of your box.

Once you are satisfied with your added tabs in the preview, click the ’OK’ button to apply the 
interlocking tool to the parts. In the Combo View under your main document, there is now an 
object called ’MultiJoin’. Within this file tree, there are now parts that are the tabbed version of 
your original parts, and there is also an invisible folder that contains the original non-tabbed 
parts. 
The preview tab also stays available – you can save this as a separate project if you like; 
however, you can close the preview tab without saving it for this example.

The next task is to apply the ’Export’ tool to the tabbed parts you have generated. Rather than 
actually export a file, this tool explodes your box apart, lays the parts out as flat parts, and 
automatically creates a drawn shape projection of the parts. In the file tree, select all the new 
tabbed parts you created under the MultiJoin object, and then click the ’Export’ tool icon.
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Once again, FreeCAD will open a new preview window tab – this will contain all the parts of 
your box separated and laid out on a single plane. You will also see some new objects in the 
file tree if you rotate the plane in the preview, as you have like this. 
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These are the ’Shape2DView’ objects – line projections of the outline of your parts. While this 
might initially seem confusing, having both versions of the parts is incredibly useful, depending 
on what you would like to do to create the parts.

Using the Shape2DView parts, you can create 2D output files that are suitable to cut this 
design using a laser cutter. First, in the file tree, let’s toggle the visibility of the 3D parts so 
that you just have the Shape2DView objects visible in the preview. (Hint: select part and hit 
spacebar)
Next, highlight all the Shape2DView parts in the file tree, and then click File > Export. 
In the export dialog, select a location to export to, and then from the drop-down menu, select 
’Flattened SVG’ as the file type. Give your export a name followed by ’.svg’ and then click the 
Save button.

You should now have saved an SVG file containing a vector line drawing of the parts you 
created. The beauty of an SVG export is that you don’t lose any dimensional accuracy, and you 
can open this file for editing in many graphics packages. You can use open-source Inkscape 
package to take a quick look at your SVG.
Find your file and open it in Inkscape. 
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Note that you can select and move each of the parts individually. This is excellent, as often you 
will want to move parts around on an Inkscape canvas to arrange your components so that you 
are as economical as possible when cutting the parts on your laser cutter. 
That might be the only edit you need to make, but often you may need to customise the SVG 
file to work with the settings of your laser cutter. You can think of a couple of different laser 
cutters that you have access to that have slightly different requirements. One needs any line 
that the laser is going to perform a cutting/vector action to be a ’hairline’ thickness of 0.0254 
mm or thinner. Another machine isn’t worried about the thickness applied to a stroke on a path 
but wants all cut lines to be red in colour. These changes are trivial to make in Inkscape. 
Of course, as a fully-fledged vector graphics package, Inkscape can also be useful to embellish 
your parts with decorations that the laser cutter will engrave/raster; again, this is simple to 
realise in Inkscape, as you have done. 
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Having made your changes in Inkscape, you can resave the file as an SVG or, of course, 
Inkscape is capable of producing many other file types that may be of use to you depending on 
your making process. Remember, sometimes simple is best – you could always print the box 
part design out on paper as a template to cut out! 
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Assemblies

You will use two other add-on workbenches, which we'll need to install. Open FreeCAD, go to 
Tools > Addon Manager, and click to install the A2plus workbench. Once installed, follow the 
prompt to restart FreeCAD, and then repeat the above task to install the Fasteners 
workbench.

Creating an assembly in CAD is useful for many reasons: it allows us to design more complex 
projects, to check that parts fit, and it allows us to use the same parts multiple times. It also 
can be used to check clearances and movements of dynamic systems and more. You are going 
to make and assemble an example of a pulley wheel mounted in some brackets, sat on top of 
a base, and held together with M6 nuts and bolts. As you are focusing on the assembly, you 
aren’t going to step through how you made every separate component. This isn’t supposed to 
be a particularly well-designed pulley block. It would need some bushings and bearings in real 
life, as well as a proper spindle, but as an example, it’s a good project to play with.

When using Part Design to create a body, that body is a single continuous solid object. The 
classic example is a nut and a bolt – which would require two bodies: one for the nut and one 
for the bolt – because although the items can be assembled, they are both single solid items. 
You could make two separate bodies within a project and then painstakingly move them into 
position relative to each other, but this is long-winded, and also, if you make a change or move 
the bolt, suddenly the nut is in the wrong place. Using A2plus, you will make assemblies where 
components are constrained to the specific parts of other components that they are attached 
to. Beyond parts simply being lined up positionally, the assembly constraints describe the 
relationship of one part to another. For example, if something can turn around an axis, or if 
one component is always parallel to another.
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You begin by making your components using Part Design to create bodies for each part. You 
create a base, two L-brackets, some nuts and bolts, a simple V-pulley, and a longer nut and 
bolt to act as a shaft. For each part you create a single project and file. 
You’ll see that you are going to import these items into the A2plus workbench, and when you 
do, you could import each body either from an individual project, a project with just that one 
body in it, or you can import multiple bodies from the same project.
Most of your files are single items, but you created one file containing two parts to allow us to 
explore how to import an individual part from a multipart project.
This is useful for many reasons. You can imagine borrowing items from unrelated projects in 
your library.You made a base which is a simple block and is the file ’base’. The base has holes 
to mount the L-brackets using M6 nuts and bolts. The sketch for the base is drawn in the XY 
plane and is centred around the 0,0 point – the bolt-holes are constrained positionally relative 
to that origin point. This means that if you change the size of the base, the bolt-holes will 
remain in the correct position, which is important because they define the L-bracket position 
and the width of the gap for the pulley wheel.
The L-brackets are again a simple part with holes that match the hole coordinates on the base 
and a hole on the upright to receive the spindle bolt. 

Join Together
You are going to make some nuts and bolts for your assembly. For this, you will use the 
Fasteners workbench you installed. Create a new project and move to the Fasteners 
workbench. The Fasteners workbench makes it easy to model metric and imperial nuts and 
bolts and screws – it even has some rarer fasteners like PEM insertion nuts, PCB standoffs, and 
more. You are going to use four M6 nuts and bolts that are 25 mm long to attach the L-
brackets to the baseplate; however, you only need to model one and then import four copies to 
the A2plus assembly project. 

To create your bolt, first click the yellow icon that looks like a hexagonal-headed bolt, which 
when you hover over it says ’ISO 4014 Hex Head Bolt’. M6 is the default diameter for this bolt 
type on the Fasteners workbench – it should create a 30 mm M6 bolt model. You’ll notice that 
the model doesn’t have any thread modelled onto it. This is common across most CAD 
platforms when modelling threaded fasteners because the thread is a complex geometry. If 
you have lots of fasteners, it can increase the project complexity and speed of loading or 
recomputing.
Most of the time in CAD, you don’t need to model the thread. However, you can simply add the 
thread to this model by highlighting the item in the file tree and, in the dialog box, setting the 
’thread’ property to ’true’. Depending on your computer, this may take some time to generate 
the thread on the model. Turn the threads back to ’false’ and shorten your bolt to 25 mm by 
selecting ’custom’ in the ’length’ property in the dialog box and typing in 25 mm. 

Let’s create a nut for your bolt in the same project file. Depending on your screen, you might 
need to expand the toolbar to select the yellow icon that looks like a hexagonal nut labelled 
’ISO 4032 Hexagon nuts, Style 1’. Again, the Fasteners workbench will automatically create a 
nut, but it will be positioned on the origin point in the same place as the bolt-head. To move 
this, double-click the nut in the file tree and then use the arrows in the preview window to 
move it down and away from the bolt. Making sure you have turned off the thread setting for 
each item, save this project ready for use in your assembly.
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Some measurements:

• Base is 100 x 35 x 12 mm with holes of 6.2 mm located at 10 mm from long side and 
31.5 mm from the middle. 
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• L-bracket is 44 mm x 44 mm x 35 mm x 8 mm with holes of 6.2 mm located 10 mm 
from long side and 25 mm from short side while the pulley-hole is located in the middle 
at 8 mm from top
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• pulley has a diameter of 66 mm with a centerhole of 6.0 mm
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• bolts and nuts are M6 with bolt full length of 45 mm and 30 mm or thread-lenght of 40 
mm and 25 mm
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Now that you have all the parts, create a new project for the assembly in FreeCAD. For ease, 
save this new project in the same folder as all the component files. 
Move to the A2plus workbench and start importing components. On the left-hand side of the 
A2plus toolbar, you should see a yellow and green tool icon, which when you hover over reads 
’Add a part from an external file to the assembly.

Click this and navigate to select the ’base’ file in the folder. Select the file and click Open. 

In the preview window, you should now have a copy of the base object inserted. 
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Let's repeat the task with the L-bracket file. The L-bracket will import overlapped with the base 
– you might notice that until you left-click, you can move it to any position in the preview area.
If you need to move it again, double-click on the item in the file tree menu and you can 
transform it incrementally using the dialog and the axis arrows. Move it to a position free of 
the base to make things easier to see. Repeat the process and import a second instance of the 
L-bracket file. The files in the file tree will automatically be given a number suffix, so you have 
L_Bracket_001 and L_Bracket_002. As an example of one way of working, simply rotate the 
second bracket so that it faces the correct way relative to the base in terms of how it will sit 
when assembled.

Let’s assemble the L-brackets to the base – to do this, select the bottom edge of one of the 
holes on the first L-bracket. This edge has a corresponding edge on the upper end of a hole in 
the base, and when in position, these two edges would sit together (Figure 4). Move the model 
so that you can see that particular hole edge, and then using the CTRL key, click to select it. 
You should now have two hole edges selected. When you select items in A2plus like this, any 
constraint types that could be applied to the items automatically become available on the 
toolbar.
You should now be able to click the ’Add circular edge constraint’ tool icon. 

You will see that the L-bracket moves, hopefully into a correct position.
You will also see a dialog box with some options showing the constraints you can adjust. You 
shouldn’t need to adjust the constraint for this one, but it’s worth noting the ’Flip’ button, 
which is commonly used if the constrained items end up in an undesired position – often 
clicking the Flip button repeatedly will toggle through the optional placements until you find 
the one you require. Click Accept to confirm the constraint.
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Double Up
Repeat the process for the second L-bracket to end up with the two L-brackets facing each 
other with the gap in between for the pulley wheel. Noting the error on the size of the base, 
let’s use that to work through how to edit a part from the A2plus workbench.
Highlight the base in the file tree and click the ’Edit an imported part’ tool icon (Figure 6). 
Clicking this should open the base part in a separate project, and the file tree of the part will 
appear. Even though you are still on the A2plus workbench, you can click the drop-down menu 
to select the primary rectangular sketch, which is the root of the base object. Double-click this 
to open the sketch in the Sketcher workbench, and then change the horizontal dimensional 
constraint to 101 mm. 
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Close the sketch and then save the base part project by clicking the Save button. Now close 
that project tab. Notice that the base in your partly assembled project hasn’t changed. To 
update the parts, click the ’Update parts, which have been imported to the assembly’ tool icon 
(a yellow part icon with two curved green arrows over it). 

Once clicked, you should see the base now fits, perfectly matching the L-bracket ends. 
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A point to consider again is that the holes in the base file are constrained to the centre line of 
the base. This means as the base dimensions are expanded, the holes stay the same distance 
apart. If you had constrained the holes relative to the edges of the base, then your update to 
the horizontal length would have moved the holes, and the brackets would still overhang. As 
you develop parts destined for assemblies, these factors become more important to consider.

Using the project with the M6 nuts and bolts you just made, let’s add the four nuts and bolts to 
connect the brackets to the base. Just as an experiment, try and import the nuts and bolts 
project using the same technique you did for the base and the brackets. You’ll note that even 
though there are two objects, it will import, but the nut and the bolt appear as a single item in 
the file tree and cannot be moved independently. The correct way to do this is to use the ’Add 
a single shape out of an external file’ tool icon. 

Having deleted your incorrectly imported nut and bolt, click this and then select the file again; 
this time, a dialog asks us to specify which part to import from within the file. Select the nut or 
bolt and repeat this for the other part. Once you have the first nut and bolt in place, let’s 
constrain this one before tackling the others.

Let’s constrain the bolt section first. Select one of the circle edges at the opposite end of the 
bolt from the head. Using the CTRL key, select one of the upper edges of one of the holes on 
the bracket. You want these two circles to align on an axis, but you don’t want to constrain the 
edges together as the bolt end circle obviously needs to be out of the other end of the hole. 
Clicking the ’Add an axis constraint between two parts’ achieves this – the bolt should now 
align to the hole. 
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To make the bolt-head sit flush to the surface of the bracket and the bolt to sit all the way 
through the hole, let’s add another constraint. This time, click to select the upper face of the 
bracket and then select the lower face of the bolt-head. These two faces can then be brought 
together by clicking the ’Add a plane constraint between two objects’ tool.

Now the bolt should be correctly in position. Click Accept in the dialog box to finish the 
constraint. 

Moving to the nut, if you move the nut closer to the bolt end under the base, you can then 
select the edge at the base of the bolt before the slight chamfer and the lower similar edge 
just inside the nut. Again, apply a ’circularEdge’ constraint to fit the nut to the bolt.

Now that your nut and bolt are constrained, you want to add the other nuts and bolts. Again, 
as an example for learning, you might think – based on other workbenches – that you can 
copy and paste the nut and bolt in the file tree system. 
Of course you can, but now that you have added constraints to your first nut and bolt, if you 
copy and paste, that will copy all the constraints applied to that part. 
Of course, you could delete these constraints and reapply them in the other positions, but it’s 
easier to either import multiple copies or to copy and paste before adding constraints to an 
object. 
However you choose, create three more nuts and bolts and constrain them into position in the 
assembly.
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Pulling Together
Let’s add the pulley wheel. Import the pulley wheel, but let’s use constraints to position it 
rather than double-clicking to use the transform tools. Select one of the edges of the hole 
through the pulley and then click one of the holes on the inside of the L-brackets in the gap for 
the pulley wheel. Even if the pulley wheel is at 90 degrees to the brackets, clicking the ’Add a 
circularEdge constraint’ should bring it into the correct orientation. 

You may need to flip the direction in the constraint dialog to get the pulley largely between the 
brackets. Before you close the constraint dialog, note that the pulley is 12 mm wide and the 
gap between the brackets is 13 mm – this is because one would probably want the pulley 
wheel to have some clearance. Currently, the pulley is positioned touching the bracket of which 
you selected the hole edge. Setting the ’offset’ to 0.5 mm in the constraint dialog moves the 
pulley 0.5 mm off the bracket and positions it equally with clearance between the two 
brackets. Finally, there is a ’Lock Rotation’ value in the constraint dialog. Setting this as ’false’ 
means that your pulley wheel part can be rotated around this circular constraint, emulating its 
real-world movement. If you wanted to lock it at a certain point in rotation, set the part in 
position and then toggle this value to ’true’.
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To finish your assembly, import the spindle bolt file and constrain it through the centre of the 
brackets and the pulley, then fit the nut to the other end. You are sure by this point that you 
can work out how to constrain this one into position without instruction.
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Keeping Backups
If you hang out in CAD circles for long enough, regardless of what CAD environment you use, 
you may come across a term for a problem. The ’topological naming problem’, or ’toponaming’ 
for short, is a common issue you can easily demonstrate in your project. Objects and parts – 
for example, the base of your pulley block – are all made out of edges and faces.
These edges and faces are automatically given an annotation. Sometimes you see these 
names when you select things like ’edge 12’ or ’face 3’. When you apply constraints in the 
A2plus workbench, you are essentially telling FreeCAD to ’attach face X to face Y’ or ’make 
edge 2 parallel to edge 5’, etc. When you edited your base part to make the brackets fit, you 
only changed a dimension, and, as such, none of the names of the features changed. As an 
experiment, edit the base and create a small rectangular pocket over one of the holes – to any 
depth – and then save the file.
As you did before, update the parts in the assembly. When you do so, you’ll see that the model 
is now a little broken, as in the image below. This is because the names of the edges and faces 
have changed, but the constraints don’t know this. It’s definitely worth having a backup of a 
saved assembly before making any major edits to parts within it. You might find that 
sometimes these issues are easily resolved by removing constraints and reapplying them.
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Quick Tip
You used the Part Design workbench and Sketcher workbench tools to create the different 
parts for your assembly. You covered these approaches in the first two parts of this series.

At the risk of sounding obvious, you can use a component part numerous times in an 
assembly, so don’t model things more than you need to!

Similar to Sketcher and other parts of FreeCAD, there are numerous ways to achieve similar 
results using different assembly constraints.
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Making multiples of things

Often when you are designing something, you would like to make multiples of some aspect of 
the design and you want to do it as quickly and as efficiently as possible. A common example 
might be placing circles to become pockets, holes, or pads in a sketch. As a first example, let’s 
go straight to the Sketcher Workbench and create a new sketch in any plane.

You can see the desired sketch item, a small square with a hole in each corner. 

To create this sketch, you drew four separate circles and constrained each of them 
dimensionally and positionally. It’s a fine approach, but it’s quicker to use some of the cloning 
and array tools the Sketcher Workbench offers. In Sketcher these tools can create matching 
objects and carry over some of, or manipulate, the existing constraints to save us some time. 
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Starting over, if you draw one circle for example in the upper left-hand corner of the square, 
you can constrain the radius and then the position by setting a vertical and horizontal distance 
constraint between the centre point of the circle and the origin point of the plane. 

Next, select the circle and the Y axis datum line. You can now click the ‘Create symmetric 
geometry with respect to the last selected line or point’ tool icon. 

This should now create a second circle, with the same radius constrained and in a mirrored 
position in the upper right-hand corner of your square. It doesn’t have the positional 
constraints, but it is in the same mirrored position as the original, so if you add a vertical and 
horizontal constraint without changing the default position then they will remain correct. 
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Of course, you can then select the two circles and the X axis datum line and repeat the process 
to create two more circles in the lower left and right corners.

Another approach is to use an array tool called ‘Create a rectangular array pattern’. 
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Starting again with just your upper left constrained circle highlighted, click this tool and you’ll 
see a dialog box. 

In the dialog, set the column and row number each to ‘2’ and then tick the ‘Equal 
vertical/horizontal spacing’ checkbox as well as the ‘Constrain inter-element separation’ box. 
Clicking OK, if you now move your mouse around the sketch area, you will see a line 
protruding from your original circle; this represents the angle at which your array will be 
created and the distance from the original circle. Left-click to place the rectangular array of 
circles into the sketch. 
Don’t worry if you set it at a slight angle: click on the generated angle constraint and set it to 
zero degrees. Finally, edit one of the distance constraints it has added; as your original circle is 
12 mm from the datum point vertically and horizontally, you set the constraint distance to 24 
mm, which makes your square array of circles fully constrained and accurately placed.

Design Parts With Part Design
For your next examples, let’s move to the Part Design Workbench and create a body and then 
create a sketch in the XY plane. In the sketch, draw a simple rectangle and don’t worry about 
constraining it. Close the sketch and pad the sketch to any thickness. Next, select the upper 
face of the padded rectangle in the preview window and click to create a new sketch on that 
surface. Select the ‘Create a slot in the sketch’ tool and draw a small slot at one end of the 
rectangular surface. Close the sketch and then perform a pocket to cut the slot into or through 
the pad. Just to add to the example, select an edge of the slot and apply a fillet, which should 
auto-complete around the entire pocket edge.
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The Part Design Workbench has some specific array tools, and you are going to try the ‘Create 
a linear pattern feature’. With nothing selected in the file tree, click the linear pattern tool. 

You should now have a dialog opened in the Tasks tab of the Combo View window. At the top 
of this dialog, you should see a panel titled ‘Select feature’ and all the available features should 
be listed; in this case, that is the pad, the pocket, and the fillet. For now, highlight just the 
pocket item in the list and click OK. You may see a duplicate pocket in the other end of your 
rectangle now, but don’t worry if you don’t. You should see that the dialog box in the Tasks tab 
has now changed; scroll down to the bottom of this new panel. You should see two adjustable 
parameters: ‘Length’ and ‘Occurrences’. The value of Length represents the length of the array 
and isn’t linked to the length of any attached object. At the default length of 100 mm with two 
occurrences, this might place the second occurrence of the pocket outside of the rectangular 
pad. Increase the number of occurrences to 5 and adjust the length of the array so that your 
array of pockets fits in the rectangle. You might also discover that if the length is shorter than 
the multiple widths of the pocket, it will overlap the pockets in the array. 
Before you close this example, you’ll note that your fillet hasn’t been replicated in the array. To 
add the fillet, click the ‘Add feature’ button, then either select part of the original fillet by 
clicking it in the preview window. Alternatively, you can swap to the Model tab and select the 
fillet in the file tree. Now, when you click OK on the linear pattern dialog in the Tasks tab, you 
will see the array with the fillets added to each instance of the pocket. 
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Removing a feature is slightly counter-intuitive in that you can’t select the feature to remove in 
the list in the ‘Add/remove feature’ box in the dialog. Similar to adding a feature, you click the 
‘Remove feature’ button and then highlight the feature in the preview or in the file tree view. 

Round And Round
Sometimes you might want to make an array of objects radially. As an example, start a new 
body and in a sketch on the XY plane, draw a circle with 30 mm radius; constrain the centre of 
the circle to the datum point. Close the sketch and pad the circle. Similar to your earlier 
example, create a sketch on the top surface of your cylinder and draw a small slot to create a 
pocket. First, leave the slot without constraints and position it somewhere in the upper left 
quarter of your cylinder face and perform the pocket.
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Again, with nothing highlighted, click the ‘Create a polar pattern feature’ tool icon. 
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The resulting dialog box is similar to your earlier linear pattern tool. Select the pocket that you 
made. Scrolling down, leave the axis and angle settings as the default and set the occurrences 
to 5. If you have the ‘Update view’ box ticked, you should see that the pocket is replicated and 
rotated around the datum point. As your original slot was off axis, the array positioned the 
repeated slots relative to this original position. 

Page 103 of 212



You can of course go all the way back to the root sketch of the pocket and adjustments will be 
recomputed to the pattern array. Close the polar pattern dialog and open the slot sketch in the 
file tree. In the slot sketch, constrain the slot so that the centre of the slot is positioned on the 
Y axis datum line.
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On Repeat
Many times you will want to create more complex arrays, sometimes with more complex 
geometries or sometimes not in a single continuous body, which means you would be working 
outside of the Part Design Workbench. The built-in Draft Workbench has some array tools that 
can be extremely useful for this, but it’s a useful Workbench for much more as well.

As a simple example, let’s start a new empty project and move to the Part Workbench. Click 
the ‘Create a cylinder’ tool to create the default 10 mm tall cylinder with 2 mm radius. Next, 
use the drop-down menu to move over to the Draft Workbench. Let’s highlight the cylinder in 
the file tree and then click the array tool icon, which resembles a collection of six blue 
rectangles. 

In the dialog box, the first items you can adjust are the ‘Number of elements’; edit the X and Y 
values to 5 and leave the Z at 1. This is then aiming to create a rectangular array of 5×5 of 
the cylinder object. Next, you can edit the spacings of the array. It’s slightly counter-intuitive 
in that the X, Y, and Z elements each have an X, Y, and Z input box, but if you play with the 
values and apply the array, you’ll soon see what effect these have. For now, in the ‘X intervals’ 
section, set X to 10 mm. In the ‘Y Intervals’ section, set Y to 10 mm and leave the Z, as you 
only have one layer in your array. Clicking OK, you should now see an array of your cylinders 
spaced at the intervals you set.
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Highlight the array item in the file tree and delete it. You should now see your cylinder item 
and if you highlight it and press the SPACE bar, we’ll make it visible again. Next, let’s try the 
‘Polar array’ tool from the Array tools drop-down menu. 
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In the dialog, leave the polar angle set to 360 degrees to create a full circle array and set the 
number of elements to 5. You need to add a point which is the centre of rotation; if you left the 
centre of rotation set at the 0,0,0 point, you would simply create five cylinders placed on top 
of each other. Change the Y co-ordinate to 10 mm and then click the OK button. You should 
now see a circular array of five cylinders appear.

Delete the polar array and let’s try the circular array tool. Highlight your test cylinder and click 
the ‘Circular array’ tool icon. This tool works differently in that the number of copied objects in 
the array is dependent on the size and spacing of the array rather than a directly input value.
In the dialog box, the ‘Radial distance’ is the radius of each circle in the created array; you set 
this to 50 mm for a test. If you don’t change the centre of rotation and leave it at the datum or 
zero point, then the first circle in your array will be made with a 50 mm radius from this point. 
The second circular layer will be made at a further 50 mm from the first circle so therefore will 
have a 100 mm radius, etc. Next, the ‘Tangential difference’ is the spaced distance between 
instances of the array object in the same circular layer of the array. You initially set this to 15 
mm, but play with this value to see how it affects your test arrays. The ‘Number of circular’ is 
the number of concentric circles that are added, spaced as you said at the radial distance; you 
set this to 3 for your test. Finally, there is the Symmetry input. It’s difficult to explain the 
effect, but this value controls the number of symmetric planes an array has – the best thing is 
to start with it set to 1 and then change the values and see what effect it has on your array! 
With the above settings, you should see an array similar to this.
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We’ve seen that the Draft Workbench array tools can be used to create arrays of copies of a 
part, but they can also be applied directly to sketches and even be applied to bodies created 
on the Part Design Workbench. The caveat with arrays of a Part Design body is that the array 
will usually create separate objects that cannot be considered part of the original body. When 
this occurs, the array is listed outside of the active body in the file tree and the original body 
part visibility is toggled off.
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Curved Line
As a final example exploring arrays, let’s create a complex-looking decorative array using other 
Draft Workbench tools to create the underlying geometries. 

Create a new project and move to the Draft Workbench. You should see a grid on the XY plane. 
If you don’t, find the ‘Toggle Draft Grid’ icon, which looks like a mesh and is at the end of the 
snap toolbar icons; toggle this button until you see a draft grid.

You may notice that the Draft Workbench has a collection of drawing tools that look similar to 
the Sketcher drawing tools. They do work in very similar ways, but in the Draft Workbench, 
wires and edges are drawn without constraints and use either snapping to the grid or other 
objects, or inputting positional coordinates. 

As such, the Draft Workbench has a lot of options for different snapping styles. For your 
example, you need to enable snapping by clicking the ‘Snap Lock On/Off’ padlock icon. 

This should now activate the other snap icons. You want ‘Snap grid’ and ‘Snap near’ to both be 
on. 

First, let’s draw a polygon on the Draft grid so that it sits on the XY plane. Click the ‘Create a 
regular polygon’ tool icon. In the properties dialog you can set the number of sides you want 
for your polygon. Set it to 5. Then left-click to draw a polygon around the datum or zero point. 
To help you draw it accurately, zoom in towards the datum point and you should see the cursor 
lock to the grid before you click to draw. Adjust the polygon placing circle to roughly 6 mm in 
diameter. If you create the default triangle, you can highlight the Polygon object in the file tree 
and adjust the number of sides in its properties table.
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Next, let’s create some points which you will use to create a curved line in three axes. The first 
point of the line is going to be the centre of your polygon, or the zero point. Click the ‘Create a 
point object’ and click to place a point at the datum. 

Next, let’s add a second point and then raise it on the Z axis. You are aiming to create a curve, 
so place this second point on the XY grid at a random point close to the zero but not on it. You 
went with an X co-ordinate of 6 and a Y co-ordinate of -2. Having created this second point, 
you highlighted it in the file tree and, in the dialog, adjusted the Z axis position to 30 mm. You 
may need to adjust the zoom, but you should see this point now rise up above the plane. 
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You added two more points above: the next had the co-ordinates X = -28, Y = 0, Z = 60, and 
the final point was at X = -10, Y= 9, Z = 80.

Creating a curve between the points you just made is easy with the ‘Create a multiple-point B-
spline’ tool. 

Select this tool and hover near the upmost point you just made. When you are hovering, if you 
are too far away from the raised point, you’ll see that next to the pointer position there is an 
icon that looks like the Draft grid icon; this indicates that if you click, you’d be snapping to the 
grid. If you are close enough to the raised point, this icon disappears, and if you left-click, you 
will attach the B-spline to the point. Left-click on the upper point and then move to the next 
lower point and left-click again; continue to do this until you reach the last point at the zero 
position. Left-click to attach the last point and then click the ‘Close’ button in the properties 
dialog.
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Just for a moment, you are now going to switch to the Part Workbench to use the sweep utility. 
On the Part Workbench, click the ‘Utility to sweep’ tool icon.

In the dialog, select the Polygon item you drew from the left-hand list, and click the right-
facing arrow to add it to the right-hand column. Next, click the ‘Sweep Path’ button, then left-
click on the B-spline curve you drew in the preview window and click ‘Done’. Check the ‘Create 
solid’ box and click OK. You should now have a curvy swept hexagonal object in the preview.
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Moving back to the Draft Workbench, select the swept object in the file tree and then click the 
polar array tool icon. You put your centre of rotation at around -30 mm on the X axis to create 
your array of five of your swept items. 
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Follow The Path
Sometimes you will want to create an array of objects, but constrain them onto another object 
or path. This can be achieved using the path array tool. In a new project, once again go to the 
Part Workbench and create a first cylinder and set the radius to 30 mm and leave it at 10 mm 
tall. 
Then create a second cylinder and leave it with the default dimensions of 10 mm tall and 2 mm 
radius. Move back to the Draft Workbench and first select the object of which you wish to 
create an array. Let’s select your second, smaller cylinder. Next, you select the path you want 
the array of objects to be connected to. Holding CTRL/CMD, click the lower outer edge of the 
larger cylinder. Then click the ‘Path array’ tool. 

This applies an array without a pop-up dialog box, but the resulting array has some editable 
parameters in the Combo View window. You should see the array has been created with four 
instances of the smaller cylinder placed equidistantly around the larger cylinder edge. If you 
highlight the array object in the file tree and adjust the ‘Count’ parameter, it will add or 
remove instances from the array and redistribute the count to maintain equal distances 
between each instance.
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Quick Tip
Press SHIFT+V or SHIFT+H to quickly add a horizontal or vertical distance constraint between 
two selected points or a selected edge.
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Surfaces and projection - Turn lines and sketches into solid objects

You are going to start with a sketch, but you are going to explore creating surfaces from 
sketches or wires to build an object. To begin, let’s go to the Sketcher Workbench and create a 
new sketch on the XY plane.
Select the ‘B-spline by control points’ option from the ‘Create a B-spline in the sketch’ drop-
down in the drawing tools area. 

Draw a collection of B-splines around the origin point, making sure that the final B-spline ends 
at the first B-spline point. 

You aren’t aiming for anything in particular, just an interesting curvy outline that has some 
inner and outer swooping curves. Play around moving the B-spline control points until you get 
a shape you like that doesn’t have too tight a set of curves. 
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You don’t need to constrain the B-spline that you have just created, so go ahead and close the 
sketch.

Moving back to the Part Workbench, select the sketch in the file tree, and copy and paste the 
sketch to create a second identical sketch that will appear as ‘Sketch001’ in the file tree. Select 
this second sketch in the file tree and, in the sketch dialog, increase the Z axis value in the 
Placement > Position drop-down to move the second sketch directly above the first. You moved 
your copied sketch upwards by around 50 mm.
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You should now see, in the preview view, two sketches perfectly aligned above one another. 
Select both the sketches in the file tree and let’s create your first surface by clicking the 
‘Create a ruled surface’ tool icon. 

Hopefully, you now see that a surface has been created between your two sketches, similar to 
this.

You’ll notice that, as it stands, your surface doesn’t have any thickness and your object isn’t a 
solid part with a top and a bottom. If you wanted to create a solid shape, of course, you would 
have used a single sketch and the pad or extrude tools. Instead, let’s aim to make your curved 
wall into a sort of tray with a base, and turn your ruled surface into a wall with some thickness, 
but open at the top. 
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First, let’s make the ruled surface you created, have some thickness. 
But, just for fun, let’s look at the wrong way to do this using the extrude tool. Doing this 
incorrect experiment makes us think about the projection of axes through workpieces, which 
you will return to as a subject later. Select your ruled surface and click the ’Extrude’ tool in the 
dialog. 

select the Y axis as a custom direction and set to extrude it a couple of mm. Apply the 
extrusion. Inspecting the results, you’ll see that it works for some parts of the surface but not 
for others, as the extrusion is projected across the ruled surface in the Y axis. Applying an 
extrusion like this also leads to some parts of the extrusion being added inside the boundary of 
the ruled surface, but other parts extruded outside. Select the extrusion in the file tree and 
delete it, and toggle the ruled surface so that it is visible.

A simple way to solve this is to use the “Utility to offset in 3D” tool. 

Highlight your ruled surface and then click this tool. In the dialog set your offset amount to 
3mm and leave the mode setting as “skin” and the join type as “Arc”. Click to check the 
“update view” box in the lower left-hand area of the dialog. You should see that you have 
created an internal second surface running parallel to your original ruled surface at a distance 
of 3mm. If you wanted to create this offset on the outside of your ruled surface then adding a 
negative number orientates the new surface correctly. 

You’ll note that the 2 walls are separate and unfilled – click the “fill offset” option and the 
two ruled surfaces become a filled object. 

Click OK to apply the offset. One of the best parts of using FreeCAD is the ability to apply 
multiple operations or tasks to a single piece of geometry. 
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To add a base to your curvy wall, to make it into your curvy tray, you can use the drop-downs 
in the file tree to go all the way back and select your original sketch. You can then click the 
Extrude tool and add -3 mm to the Z axis custom direction and set the length option to 0. 
Clicking Apply, you should have added a base underneath the offset wall to complete your tray.
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Previously, when you have worked with solid objects, you have often created sketches either 
attached directly to a flat face of an object or drawn on a plane, like XY or XZ, and then 
extruded or pocketed through an existing solid. With a curved object, such as the wall of your 
tray, drawing directly onto the surface is not really possible. However, you might often want to 
add design aspects to a curved surface. One approach to this is to use ‘projection’. 

Imagine placing your hand in front of a display projector and seeing the shadow of your hand 
on the projection surface on the wall or whiteboard. You can do this in FreeCAD, except the 
projector is referred to as the camera view and is simply the current view in the preview 
window. The equivalent of your hand is the object you want to add to a surface, and your ruled 
surface is the object onto which you want to project. Whilst this might sound complex, it’s 
actually pretty straightforward to do.

Being in Parts workbench, create a cylinder with raduis 10 mm, height 10 mm and postion it 
outside your curvy tray (Z = 100 mm)

First, you need to choose which surface area of your object you want to project the logo onto. 
You can project parts onto any surface, but obviously if the surface is very folded, the effect 
isn’t going to work as well; therefore you chose a larger, smoother face. 
You then need to orient that chosen face to be pointing at us when viewed in the preview, 
remembering that the preview window is the projection viewpoint. With that established, you 
then need to move your object you want to project onto the curved surface into a position in 
line with the projected surface and the preview window. You can do this via the usual right-
clicking the object in the file tree, selecting Transform, and moving and rotating the object 
until you are happy with the position. 
It’s not too critical how far away from the surface the object is, but it’s a good idea to leave a 
reasonable gap so you can see the effects of the projection. In Figure 7 overleaf, you have 
rotated the preview view to show how your projection was set up.
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With your preview view and your projection object correctly set, 

click the ‘Project edges, wires, or faces of one object onto a face of another object’ tool. 

In the dialog you will see a long button that says ‘Select projection surface’ – click this button 
and then select the surface onto which you want to project. Next, click the ‘Add face’ button 
and select the face of the object you wish to project that is visible in the preview view. It may 
take a few seconds, but the selected face should turn a purple colour. 
You’ll need to change the extrude height to a value that works for the shape of your projection 
surface. In your example, the extrusion height was 10 mm – this gave enough height for the 
whole to be projected to the lowest parts and highest parts of the curve of the ruled surface. 
Experiment with values until you get a projection that works for you. 

Finally, click ‘OK’ and you should now see your object projected onto the curved surface of 
your tray part. Of course, now you can remove or toggle the visibility of the part you used to 
make the projection.
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A common use for projection is to create 3D text effects. Let’s first look at how to generate 3D 
text in FreeCAD, and then let’s use some text and project it onto your curved surface again. 
Then you can combine projecting onto a curved surface with some Boolean part operations to 
create some interesting effects. 

For simplicity, let’s just open a new project to look at the text tool you are going to use. In the 
new project, open the Draft Workbench and then click the ‘Create a shape from a text string’ 
tool icon, which looks like a yellow ‘S’. 

In the dialog, you can see some positional co-ordinate input boxes which select the point at 
which your text will be created from. If you move your pointer over the grid in the preview 
window, you will see that these co-ordinates react to where your pointer is. For this example, 
let’s leave them set at 0,0,0, which you can either type in or click the ‘Reset point’ button. 
You need to point the ShapeString tool at your font installation folder. Clicking the ellipsis at 
the side of the ‘Font file’ input box should open a file browser. On Windows 10, the location is 
usually C:\Windows\Fonts. Navigate to your font folder and select a font. 
In the ‘String’ input box, type the text you want to create, and then set the height of the text, 
noting that the text height is not in the usual ‘point’ font units found in word processing 
packages, but rather, in millimetres. Clicking OK, you should now see the text string you input 
created in the draft preview window. Notice that it creates a wire/edge, but also creates a 
surface face. 
You should also see that you have a ‘Shapestring’ object in the file tree. 

Now that you have a ShapeString object, you can move back to the Part Workbench and 
perform the usual sort of operations upon it. Whilst not totally necessary, if you extrude the 
ShapeString on the Part Workbench a little, say 3 mm, it means that you can use the simple 
‘Transform’ operation you used earlier to move the object into your projection position.
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Go back to your curvy tray project and remove the cylinder projection.
(Re)create your text in this project the same way you just did. 
You can now use the text in the same way as you used your small logo or part in the earlier 
projection example. You can see that you have again projected the text onto the curved side of 
your curvy tray example.
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You may have noticed when you set up a projection, as well as a height input box, there is also 
a ‘Depth’ box. Of course, the depth option allows you to project through the selected surface to 
a set depth. To see how this works, a useful experiment is to project into a part that is partially 
transparent. 
In a new project, create some example text using a ShapeString. 
Now return to the Part Workbench. Click the ‘Create a cube solid’ to create a cube. Resize the 
cube so that it is larger than your text ShapeString. Then right-click and select Transform. 
Move the cube item down underneath the ShapeString, ready for projection.
Click the Projection tool and select the surface of the cube item you just made. Then select the 
faces of the ShapeString in the usual way. Add 2 mm of height, but add 5 mm of depth to the 
projection, and then project onto the cube item. Select the cube item in the file tree, right-
click, and select Appearance. In the appearance dialog, slide the ‘Transparency’ slider to the 
right to set the transparency to around 40%. 
Closing the Appearance dialog, you should now be able to see that the cube is partially 
transparent, and you can see the projection is inside the cube to a depth of 5 mm. Finally, you 
can select the cube and then the projection object, and click the ‘Make a cut of two shapes’ 
tool to remove the projection from the cube object. 

Now go back and delete the cut as well as the projection. Recreate the projection but now with 
a height of 5 mm and a depth of 5 mm. Make the cut again as well. Set also transparency on 
the cut to see the cut-out of the text. This is a useful effect if you are trying to make a text-
based sign object for 3D printing
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The surface tools and projection approaches can create very complex effects and designs, but 
you mentioned earlier that they have their limits. How, for example, could you create a pattern 
or text that flows completely around a cylinder or other curved shapes? 

Surface Workbench
Using the ruled surface tool on the Part Workbench is useful. In some ways, it is the first step 
towards thinking about 3D modelling in terms of edges and surfaces – rather than creating a 
3D object via extrusion or padding, and then cutting and adding parts to and from it.
Surfaces in FreeCAD are given their own Workbench, and it’s certainly worth exploring in its 
own right. The ruled surface tool you use in this article has some limitations – one main one 
being that, if you have a closed path like the base of your curvy tray, the ruled surface tool 
can’t be used to create a surface filling the path. This is why, in the article, you create a small 
extrusion from the original sketch. If you are interested, create a sketch similar to the first B-
spline sketch you created in the main tutorial, and then move to the Surface Workbench. 
Select the first tool icon, ‘Creates a surface from a series of picked boundary edges’, and in the 
dialog, click ‘Add edge’, and then select the sketch edge in the preview window. You should see 
a surface created filling the sketch area.You hope to revisit the Surface Workbench and other 
surface tools in future articles, as it has a plethora of tools that enable complex operations in 
some ways similar to the lofting and sweeping operations you looked at in issue 40, but it’s 
even more versatile.

Vector Graphics
For your example of projecting a part onto a curved surface, you have used cylinder. However 
you can also import as an SVG and then extruded into a part. The SVG file is a single path 
outline.
The ability to import an SVG is a really useful feature occasionally, and works well. Simply 
go to File > Import and navigate to your SVG. When selected, you get a dialog asking if you 
want to import as a ‘Drawing’ or ‘SVG as Geometry’. You need to select the latter, and then the 
file is imported and appears in the file tree as an object labelled ‘Path’. On the Part Workbench, 
if you select the imported SVG, click the Extrude tool. You can extrude in the usual way. 

There are also ways to import an SVG and convert the SVG into a sketch so that you can 
constrain its contents, making it usable in other Workbenches. A useful video tutorial on this, is 
available here: https://www.youtube.com/watch?v=6LedIN5S2so.
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Design your own ring

You looked at projection as a tool to add geometries or objects onto curved surfaces. In this 
chapter, we’ll discuss the limitations of projection and look at how you can map sketches onto 
the surfaces of curved objects. 
Along the way, you will make a geeky maker ring to 3D-print, and you will also explore some 
more complex uses of the Curves Workbench.
You projected objects onto curved surfaces, and this works well in many instances. It has some 
limitations, though. The major one is that by design, projection works with a fixed projection 
view and as such, it can’t be used to wrap a design around another design. Let’s start by 
looking at how you can wrap a sketch around a cylindrical object.

Open FreeCAD and use the Addon Manager in ‘Tools’-list to add the “Curves” Workbench.
When the list populates, scroll to the “Curves” Workbench and click to install. Once 
downloaded and installed, you will be prompted to restart FreeCAD. Once you have restarted 
FreeCAD, open a new project. 
For your first example, let’s start in the Part Workbench. Click the ’Create a cylinder’ tool icon 
and then highlight the ’cylinder’ object in the file tree. 
In its dialog box, change the radius to 10 mm and the height to 30 mm. Next, let’s switch over 
to the newly installed Curves Workbench. In the preview window, select the surface that forms 
the outer wall of your cylinder, and then click the ’Map a sketch on a surface’ tool icon. 

You’ll notice in the file tree view that a new ’SketchOnSurface’ object appears and that this is a 
drop-down menu item. If you click it to open the drop-down menu, it should contain only one 
item: mapped sketch. 

If you double-click on this item, it will open the Sketcher Workbench. In the sketch, there will 
be a blue rectangle. When geometry lines in sketches in the Sketcher Workbench are blue, it 
means that they are construction geometry that acts as a guide but doesn’t appear in the 
sketch as part of the object. They have many uses, but in this case, the ’Map a sketch on a 
surface’ tool has created a construction geometry that matches the dimensions of the 
cylinder’s face and acts as a containing area for your mapped sketch. For a first simple 
example, let’s draw a rectangle somewhere inside the blue construction rectangle.
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Having drawn a rectangle inside the construction geometry, close the sketch and you should 
automatically return to the Curves Workbench. You should now see the rectangle you drew on 
the surface of the cylinder in relative position when the blue construction geometry is wrapped 
around the cylinder. If you don’t see your mapped rectangle, rotate the cylinder as it may be 
positioned out of view. You can now close the drop-down mapped sketch on the file tree and 
when you select the parent SketchOnSurface item, the small mapped rectangle should be 
green and selected in the preview window. Selecting this, you can perform some operations on 
this sketch like any other. With the sketch highlighted in the dialog, set the ’Fill faces’ option to 
’true’ and then increase the ’thickness’ a few millimetres. You’ll see the sketch is extruded out 
from the face of your cylinder.
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It’s perhaps worth pointing out that the resulting objects made using mapped sketches work in 
the same way as other objects with regard to the Part Workbench and other tools. You can add 
some fillets to the edges of the part and use the appearance menu to set the object’s colour. 
You can also go one step further in that you have clicked the surface of your mapped object 
and created another SketchOnSurface object to create the small extruded hexagon.

As well as adding more mapped sketches to build up complex geometries, you can use Part 
Workbench tools such as the Boolean operation type tools to make cut-out parts using the 
mapped sketch. As an example, you can make a fun mini project to make and 3D-print. 
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Let’s make a useful (?) 3D-printed ring. Start in a new project and once again with the Part 
Workbench. Create a cylinder that is just a fraction larger than the diameter of one of your 
fingers and around 12 mm tall.
Create another cylinder that is slightly larger in diameter but the same height – the difference 
between the first and second cylinder diameter will be the thickness of the ring. If you don’t 
move either cylinder, they should be aligned and concentric around the origin point. Select the 
second larger cylinder first and then select the first cylinder and click the ’Make a cut of two 
shapes’ tool icon from the Boolean tools selection. You should now have a basic ring shape. 
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Moving to the Curves Workbench, you will map a sketch to the outside surface of the ring 
as you did earlier with your cylinder. Click the outer surface and then click the ’Map a sketch on 
a surface’ tool icon once again. Click to drop-down and double-click the mapped sketch, which 
will open in the Sketcher Workbench. 
The idea for this maker ring is that you will cut out some hexagonal shapes that not only look 
decorative but will serve as an emergency small spanner tool. As such, inside your construction 
geometry, you added some hexagons sized to common small metric nut sizes. Go for M2, 
M2.5, M3, M4, and M5. You don’t need to fully constrain the sketch, but you can opt to align 
one line of the hexagon with a vertical constraint so that you could then constrain the nut size 
by selecting two opposite points and applying a horizontal dimension. You added roughly 0.1 
mm to the M-series given nut sizes to make them an easy fit – you can see the sizes you used 
in the constraint values. 
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If you preferred your hexagon spanners positioned randomly, you could constrain them to be 
on the centre line and more equally spaced if preferred.
Once you are happy with your hexagons, close the sketch and you should see the mapped 
sketch around your ring. Select the SketchOnSurface object and, in the dialog, set ’fill faces’ to 
’true’ – but this time, add a negative value equal to the thickness of your ring design in the 
’thickness’ input. Your ring is 2 mm thick, so you went with -2 mm. This should now have 
extruded the mapped sketch through the ring.

Now that you have all the objects created, it’s a case of moving to the Part Workbench and 
selecting the ring first, then the SketchOnSurface object, and then creating a cut of the two 
parts to create your ring. 

You can then use File > Export to save your ring as an STL file suitable for slicing and printing. 
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Using the sketch mapping tools on the Curves Workbench is just one example of what can be 
done with this workbench. Almost every tool on the Curves Workbench could have a tutorial 
written about it, but let’s look at a couple of tools to make a complex curved surface that 
curves in all axes.

You are aiming to make an object that looks like an aeroplane cockpit canopy cover as it’s a 
challenging shape to model. Again, you are not particular about the dimensions of the object 
and, as such, you are not worried about constraining aspects of the design.

To begin, create a new project, move to the Part Design Workbench and create a body. Create 
a sketch in the XY plane. In this sketch, let’s create a B-spline. This B-spline is going to be the 
lower side edge profile of your canopy cover. Click the B-spline tool and start the B-spline 
attached to the X axis to the left of the origin point. Add some points and then finish the 
B-spline to make it look similar to the this. 
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Before you close the sketch, select the B-spline that you just made and click the ’Create a 
symmetric geometry with respect to the last selected line or point’ tool to add a mirrored B-
spline on the right-hand side of the Y axis line.

Create another sketch in the active body, but this time in the XZ plane. You need to import the 
endpoints of the mirrored B-splines that sit on the XY plane (the starting end of the B-splines 
in the previous sketch). In the new XZ plane sketch, click the ’Create an edge linked to an 
external geometry’ tool and zoom in to select the endpoints of the two B-splines from the first 
sketch. Now that you have those points available, draw another B-spline that begins with the 
point constrained to the left-hand B-spline from the first sketch. Place the second B-spline 
point on the Z axis line above the origin and attach the final B-spline point to the imported 
edge of the mirrored B-spline.

When you finish this B-spline, you should have a symmetrical curve that will form the rear 
edge of your canopy design.
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You now need to add a similar smaller B-spline that will connect the front ends of the original 
mirrored B-splines to form the front edge of your canopy design. Of course, these points don’t 
sit on a datum plane, so you need to add a datum plane to work on first. Creating datum 
planes is an incredibly useful tool in many projects. To help us set up your new datum plane, 
let’s make the three standard plane origins visible. To do this in the file tree, highlight ’Origin’ 
and press the SPACE bar. You should now see the blue lines and labels for the XY, XZ, and YZ 
planes. Click the ’Create a new datum plane’ tool icon on the Part Design Workbench. 

You should see a ’Plane Parameters’ dialog box appear in the Combo view area. At the top of 
the dialog, you will see four boxes with ’No reference selected’ written in each box. To the left 
of the first box, the button text should read ’Selecting’ – if for any reason it doesn’t, click on 
that box until it does. If you imagine your desired new datum plane by visualising where you 
want to sketch, you could describe the plane as a sort of XZ plane moved to the far end of 
your original mirrored B-splines. This kind of hints as to how you will create the new datum 
plane. First, let’s click on the XZ plane that you made visible in the preview window. You 
should now see that the new brown-coloured datum plane moves onto the XZ plane. Double-
check the dialog. You should find that the first box now has ’XZ_plane’ in the input, and the 
button now says ’Plane’. Click the button until it returns to ’Selecting’. 
Finally, you need to move and zoom to select the endpoint of one of the mirrored B-splines you 
made in the original sketch. This should make that vertex point the reference of your new 
datum plane, which stays oriented as parallel to the XZ plane. Once it’s in place, you can click 
OK to close the datum plane dialog. 

With the new datum plane highlighted in the file tree, click the ’Create a new sketch’ tool to 
open a new sketch. Import the B-spline endpoints to the sketch and make a smaller B-spline to 
form the front of the canopy in the same way that you did the sketch for the canopy rear on 
the XY plane.
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To create a surface for your canopy, first you are going to make a flat ruled surface between 
the original sketch lines and then you are going to use the ’Sweep profiles on 2 rails’ tool and 
the ’Approximate points to NURBS curve or surface’ tool. 

To create the ruled surface, move to the Part Workbench, select the two B-splines of the 
original sketch, and click the ’Create a ruled surface’ tool.

Moving to the Curves Workbench, in the file tree view, select the new ruled surface object and 
select the two sketches that create the rear and front edge shape of your canopy design. With 
these three objects highlighted, click the ’Sweep profiles on 2 rails’ tool. 
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Your computer may take a little time to process this, but once it’s complete, you should have a 
collection of points, or a ’point cloud’ in the preview window that is beginning to look like the 
shape of your aeroplane canopy. 

There are plenty of options to increase and decrease the resolution of the point cloud, but for 
this example the default settings are adequate.
To convert the point cloud into a surface, make sure that the Sweep2Rails object in the file tree 
view is highlighted, and then click the ’Approximate points to NURBS curve or surface’ tool. 

You should now have a perfect canopy surface. Of course, the surface created is similar to your 
earlier ruled surface in that it has no thickness dimension – you can, however, use familiar 
tools to create a thicker solid object. With the ’Approximation Curve’ object highlighted in the 
file tree, you can move to the Part Workbench and click the ’Offset’ tool. In the offset tool 
dialog, you can create an offset and check the ’fill offset’ box to create a thicker canopy.
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We’ve seen a small range of tools on the Curves Workbench in this tutorial, but we’ve only 
scratched the surface of what this workbench is capable of. As ever, there is a heap of 
knowledge on the FreeCAD community forum as well as lots of videos and tutorials online to 
help you explore the rest.
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Curved Cone
If you want to map a sketch onto a cone shape and you want to work in Part Design, the ’Map 
a sketch to a surface’ tool works a little differently. You have to draw your own construction 
geometry and do things in a slightly different order. As an example, in a new project, move to 
the Part Design Workbench. Create a new body and create a first sketch in the XY plane. 
Create a circle roughly 100 mm in diameter around the origin point. Close this sketch. Create a 
second sketch in the XY plane and draw a smaller circle for the top of your cone around the 
origin point – again, don’t worry about constraining these sketches too much. Closing the 
second sketch to return to Part Design, highlight the second sketch and in the dialog, under 
the ’Attachment’ submenu, go to ’Position’ and raise the Z axis value – you went with 25 mm, 
to move the sketch upwards.

Select both the sketches in the file tree and then click the yellow and red ’Loft a selected 
profile through other profile sections’ tool icon. Click OK and you should have a cone. Moving 
to the Curves Workbench, select the curved outer face of the cone and then click the ’Map a 
selected sketch’ button. Different to earlier examples, you will see that a mapped sketch object 
appears without the SketchOnSurface object. Double-click the mapped sketch object and you 
will move to the Sketcher Workbench, but there won’t be any construction geometry.
Toggle the ’Toggles the toolbar or selected geometry to/from construction mode’ button to turn 
the sketching tools blue, and then draw a construction geometry rectangle from the origin 
point. You can work out the exact shape and size of the curved cone surface limits, but for this 
example you just drew a rectangle that would fit on the cone surface with room to spare.

Toggle the Sketcher tools back so that they no longer draw geometry objects, and 
draw an object inside the rectangle. You went for a ‘slot’ object. Close the sketch to return to 
the Curves Workbench. Finally, select both the ’additive loft’ object that is your cone and the 
mapped sketch in the file tree and then click the ’Map a selected sketch’ button again. It 
should now create the SketchOnSurface object and map your slot onto the cone’s surface. 
Similar to earlier examples, you can add thicknesses and perform cut operations to create your 
design.

Quick Tips
Often in mapped sketches objects cover the construction geometry. Click the ‘When in edit 
mode switch between section view and full view’ tool to solve this.
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Getting Meshy in FreeCAD

STL files have been around since the 1990s, and in simple terms, they contain a mesh of 
triangular facets that describe the shape of the design. STL files are a common mesh 
format to use in 3D printing where they are imported into a ‘slicer’ piece of software that 
generates the G-code for the 3D printer to follow. 
As such, STL has become a standard file type for sharing 3D print designs on sites such as 
Thingiverse and GrabCAD and more. Whilst heavily associated with 3D printing, STL can often 
be used for other processes such as CNC milling or routing.
Most of the time, for simple parts, creating an STL file in FreeCAD is simple and somewhat 
automated. 
As an example, let’s quickly create any object in the Part or Part Design workbench. You can 
create a cube object and a sphere object in the Part workbench and cut part of the sphere out 
of the cube.

With the cut object selected in the file tree, click File > Export and you should see that 
FreeCAD suggests you export the object as an STL file. Give the file a name and export it, and 
it’s ready to be sliced for 3D printing. In the background, FreeCAD has made a lot of sensible 
choices about the resolution of the mesh of your exported part. 
Put simply, FreeCAD makes a choice about the number of triangle facets your exported STL 
mesh object contains.

Sometimes you might want to have more control over the mesh that‘s created for your part, 
and you might want to change the resolution to get the best results for your project. This is 
one area where the more specialised tools on the Mesh workbench can help. 
As an example, you have a nose cone part for a rocket designed – let’s move to the Mesh 
workbench using the drop-down menu to create some different resolution meshes to compare.
On the Mesh workbench, highlight the nose cone part and then click the tool that reads 
‘tessellate shape’ on the tooltip as you hover over it. 
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This tool is also accessible by clicking Meshes > Create mesh from shape. You should see a 
dialog box in the combo view area, and you should see two changeable values on the Standard 
tab. 
The first value, ‘Surface deviation’, should be 0.10 mm, and the second value, ‘Angular 
deviation’, should be 30 degrees. If they aren’t, set them to these values and then click OK. 
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Resolving Resolutions 
You should now have two objects in the file tree: your original nose cone part and the new 
mesh object. Similar to other items in the file tree, you can toggle the visibility of the mesh 
and the part by highlighting the object and pressing the SPACE bar. Select the original nose 
cone part and set it as invisible so that you just see the mesh object in the preview window.
You can see that the created mesh consists of lots of triangles closely approximating the part, 
but you can adjust the values to increase the resolution of the mesh if you delete your first 
mesh, make the nose cone part visible, and highlight it so you can create a new mesh. 
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For this mesh, let’s set the surface deviation to 0.03 mm and the angular deviation to 10 
degrees. You should see that the resulting mesh is a higher resolution and more precisely 
matches the original part. 

Of course, this also increases the complexity of the mesh and, if taken too far, may well begin 
to slow down your graphics card performance. 

To export a mesh from the Mesh workbench, you can highlight the mesh in the file tree, right-
click, and select ‘Export mesh’. There are numerous options of STL types, but you tend to 
export as ‘Binary STL’ and, these seem to work well with your slicing software for 3D printing. 
One thing to note is that the Export mesh function seems to want us to add the ‘.stl’ to the file 
name in the name input box.
Of course, creating a mesh file from an object you made in FreeCAD is just one small aspect of 
the work of the Mesh workbench. One area it is particularly useful in is for editing and 
amending mesh files. This scenario often arises when we’ve found an object online that you 
wish to 3D-print but will require some reworking. Often, if you are downloading an object 
from a website such as Thingiverse or GrabCAD, you may only have the option 
to download a mesh file/STL, or indeed you might have the project file but it is made in 
software that you don’t own.
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As an example, you have an STL file of a hands-free door puller. 
Let’s pretend that, in use, you decided it would be better if the hook faced the other way 
round. You could, of course, with the knowledge within this FreeCAD series of articles, draw 
this part from scratch in a matter of minutes, but let’s use the Mesh workbench to make some 
changes. Click the ‘Imports a mesh from a file’ tool icon and navigate to the STL file and select 
to import 
it.

The Mesh workbench has some tools that are similar in approach to the Part workbench, where 
you create simple solid objects and combine them using Boolean functions to stick objects 
together, or subtract one shape out of another. If you want to turn around the hook part of 
your mesh file, you will create a copy of the hooked end and rotate it using these tools.
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Regular Solids 
First of all, click the ‘Build a regular solid’ tool icon or select the same tool by clicking Meshes > 
Regular solid. 

You should now see a small window with a drop-down to select various shapes, cubes, 
cylinders, etc., and some entry boxes to add dimensions. You will create a cube 35 mm long, 
50 mm wide, and 10 mm high. 
Similar again to working with solids on the Part workbench, if you highlight the cube object 
in the file tree, right-click and select Transform, you can then move the cube into place over 
the hooked end of the door puller.

Next, select the two objects in the file tree and click the ‘Intersection’ tool icon. You will now 
see an additional item in the file tree labelled ‘Intersection’. 

If you toggle the cube item to be invisible and then select the intersection item, you can then 
right-click and use Transform to move the intersection object, which is a copy of the hook 
section, away from the rest of the door puller object. Next, make the cube visible once more, 
select the door puller object and the cube and then perform a ‘Difference’ Boolean 
operation on it. You should now have a version of the original door puller with no end and a 
copy of the hooked end.
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All that remains is to move and rotate everything into the new position, and then you can use 
the ‘Union’ Boolean operation to create a new single mesh object. You can then highlight the 
new door puller union object and click the ‘Export a mesh to file’ tool to create your new STL 
file ready for 3D printing.Continuing to use your door puller tool project as an example, let’s 
explore how you create a Part object from a mesh. Moving to the Part workbench, you can 
highlight the mesh – in your case called ‘Union’ in the file tree view – then click Part > Create 
shape from mesh. You should now see that a part has been made of your door puller object.

Let’s make your mesh object invisible in the file tree to explore your part. 
You should see that the part object creates its faces and edges based on the triangles in the 
mesh, which means that it is an accurate copy, but also means it can be a little challenging to 
work with. You can, of course, select faces and map sketches to faces, which is pretty 
straightforward on larger flat sections of a part but gets challenging if you consider the curved 
part of your puller. It can also be useful to convert meshes to parts if you want to recreate 
aspects of a mesh design. Converting a mesh to a part means that you can use the ‘Link to an 
external geometry’ tool in the Sketcher workbench to pull in reference points to create 
sketches over parts converted from meshes.   
Sometimes you might want to work with extremely complex mesh files. If you’ve ever 
downloaded a complex model, such as a model of a person or object that’s full of complex 
organic curves, you might notice that your graphics card starts to slow down when you 
manipulate the object. The FreeCAD Mesh workbench has a handy tool to play with optimising 
the mesh resolution that may be able to reduce the data, or put simply, the number of 
triangles in a given mesh while still retaining enough detail. This tool is called the ‘Decimation’ 
tool. Mesh decimation must be used in moderation, as taken too far, it’s easy to completely 
destroy the object, which can also be a fun experiment. In the preview window, let’s zoom in 
so that you have a close view of a part of the internal chamfer on the large hole in your door 
puller object. 
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Notice that when zoomed in, you can see the facets that make up the mesh surface. As this is 
a small file, we’ve made this mesh a pretty high resolution, but let’s explore the effects of 
decimation. First, select the door puller object, in your case called ‘Union’ in the file tree. 
Notice that in the dialog box, once selected, you get some details of the number of points, 
edges, and faces your mesh contains. For us, these are 1606 points, 4818 edges, and 3212 
faces. Next, click the ‘Decimates a mesh’ tool, which appears as a green diamond-shaped tool 
icon. In the Decimating dialog box that appears, set the reduction level to 50 percent and 
leave the absolute number box unchecked. Click OK. In the preview window, if you are still 
zoomed in, you should notice the resolution of your puller part change, it should look cruder 
and the triangles should be more obvious.

If you check the details of your mesh object in the dialog box, you can see it has reduced the 
number of points, edges, and faces by 50 percent to 803 points, 2409 edges, and 1606 faces. 
This carries through to affect the file size of an exported mesh, and indeed, exporting this 
decimated version creates a file size percent smaller than the none decimated mesh. If you 
zoom out on your 50 percent decimated mesh version of the door puller, you’ll see that it 
makes 
very little real-world difference to the resolution of the object, and the size and shape of the 
object is unchanged. You can experiment with the decimation value – it can be quite amusing 
to see what happens to a shape when you approach the near 100 percent decimation values.
Sometimes you might work with mesh files, or indeed create mesh files, that have issues and 
problems. The Mesh workbench has a tool that enables us to quickly and repeatedly analyse 
meshes for problems. With your mesh object highlighted, click the ‘Opens a dialog to analyse 
and repair a mesh’ tool. 
This should open a large dialog box on the right-hand side of the preview window. There is a 
list of potential problem items that FreeCAD can analyse a mesh for. You can analyse a mesh 
for each item on the list individually, or you can click ‘Analyse’ on the ‘All above tests together’ 
option at the bottom of the list. Close that dialog box for now, and let’s quickly make a new 
simple object with a problem! In a new project, move to the Part workbench and create two 
identical default cube solid objects. 
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These default to 10 mm cubes, using Transform, move the second cube object up 10 mm in 
the Z axis and across 10 mm in the X axis. Finally, highlight both cubes in the file tree view 
and perform a Union operation to make the two cubes – one part called ‘Fusion’. Moving to the 
Mesh workbench, with your fusion object highlighted, click the ‘Tessalate shape’ tool icon to 
create a mesh object. You can see the resulting mesh imported. 

Make the original solid part fusion object invisible in the file tree, highlight the mesh object, 
and then reopen the mesh analysis dialog as before. Double-check that your mesh object is 
the object listed in the Mesh Information section (especially if you have multiple projects 
open), then click the Analyse button on the ‘All above tests together’ option. The tests will run 
quickly, and you should see just one error reported.You should see that in the list of analysis 
areas in the dialog, the ‘Non-Manifolds’ section has a check box with one non-manifold issue 
found. A simple way to think of this common error to understand when something is non-
manifold is to consider if it is possible to be manufactured. In this instance, your two cubes are 
only connected at one edge and they do not overlap at all, which means, in essence, that the 
connected edge is infinitesimally small. 

Of course, it’s impossible to create a connection between these objects, and as such, they are 
described as non-manifold. Another way to create a non-manifold example is to create a tube 
with no ends where the surface of the tube has no thickness – this can be done using lofting 
tools or sweeping operations in FreeCAD, for example.
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Fixing The Issue 
Having analysed your cubes example and found the non-manifold edge issue, you may well be 
tempted to click the Repair button next to the offending issue in the dialog box. If you try this, 
FreeCAD will automatically apply a repair, but be prepared for this to fail as it will only work 
occasionally on simple problems, such as a small gap on a surface that needs closing. It’s 
always worth a try, however, and you can always undo any odd changes the repair functions 
apply. For the sake of completeness, let’s manually create a solution. If you move back to your 
part object and delete the fusion object so that you have your two separate cubes, move the 
upper cube back over and into the lower cube creating a couple of millimetres where they 
overlap. Then create a new mesh and analyse it – you should see that you have cured the 
manifold issue.
Finally, while we’ve looked at some useful stuff on the Mesh workbench, you have only really 
scratched the surface of what’s available. As ever, there is lots more information, and tutorials, 
to be found online on both the FreeCAD community forums and in the FreeCAD wiki. 

OpenSCAD
FreeCAD is a community-developed, open-source piece of software that uses other open-
source pieces of code and modules within it. Another excellent open-source piece of CAD 
software is OpenSCAD, which uses a code-based approach to 3D modelling. 
Files and models created with OpenSCAD can be imported directly to FreeCAD. FreeCAD has an 
OpenSCAD workbench to enable people to use the best of both software approaches.
In the Mesh workbench some of the functionality, including the Boolean operations you are 
using in this article, require OpenSCAD to be installed and a path to the OpenSCAD executable 
to be set up in FreeCAD. 
Head over to openscad.org and download and install the latest version for your operating 
system. Once installed, back in FreeCAD, move to the OpenSCAD workbench and then click 
Edit > Preferences and scroll down to select the OpenSCAD icon. In the Preferences dialog, the 
first item is an input box to set the file path to the OpenSCAD executable – your system should 
have detected the correct path, but it’s worth opening the file location and checking it is all set 
correctly. Once checked, click the Apply button and close the preferences.
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Quick Tips 

• While STL files are the most common mesh file, they aren’t the only ones. In fact, many 
would argue that STL are not great files for mesh objects.

• The Intersection, Union, and Difference Boolean operation tool icons look like green 
versions of their counterparts on the Part workbench.

• You might want to install the brilliant Rocket workbench using the Add-on Manager if 
you want to play with the nose cone design.

• Another useful tool on the Mesh workbench allows us to scale mesh object. Simply 
select the mesh in the file tree and click the ‘Scale selected meshes’ tool icon.
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Intermediate sketching

Often a sketch is the foundation of a part, and we have looked at the basics. Let’s delve deeper 
into more intermediate features and approaches for sketching in FreeCAD

Previously, we have looked at the basics of sketching in the Sketcher workbench and then 
occasionally looked at other Sketcher features, such as cloning and making multiples of 
objects. As such a fundamental approach to creating parts, it’s certainly worth looking at in 
more depth.
To begin, let’s revisit an approach we have used previously which we can use as an example. 
Open up FreeCAD and start a new project, move to the Part Design workbench, create a body, 
and then create a sketch in the XY plane.
In your new sketch, draw a rectangle using the ‘Create a rectangle in the sketch’ tool and don’t 
worry about constraining it. Close the sketch and, back on the Part Design workbench, use the 
Pad function to pad the rectangle sketch into a larger cuboid. 
Next, select any face on the cuboid in the preview window and click the ‘Create a sketch’ tool 
to open a sketch that is attached to that face.

If we imagine that we want to add a hole to the upper right-hand corner of our selected face, 
and that we want the hole to be specifically placed with respect to the upper right-hand corner, 
this is slightly tricky. It’s tricky, as the sketch underlying the cuboid object is unconstrained 
and we don’t know its size or its position relative to the origin point. We have used a tool 
previously though that allows us to import underlying geometry and help us solve this issue. 
The tool we have used is the ‘Create an edge linked to an external geometry’ tool which, when 
selected, allows us to select underlying geometry objects, edges, and points, and make them 
selectable in the current sketch. So, to accurately place a hole positionally relative to the upper 
right-hand corner, we can simply select the right-hand edge of the cuboid and then, in turn, 
use that imported geometry to set horizontal and vertical distance constraints to the centre of 
our hole circle sketch.

Page 153 of 212



In essence, what we have done in our hole, in a cuboid example, is use an underlying 
geometry to create a guide point in the new sketch onto which we can attach constraints. We 
can see, therefore, that guide points can be incredibly useful, but often we may need a guide 
point in a position where there is no underlying geometry that we can import. An incredibly 
powerful feature of the Sketcher workbench is that we can switch all the drawing tools to 
‘construction’ mode. 
In a new project, again move to Part Design, create a new body, and create a sketch in the XY 
plane. Find the tool icon that looks like a red box over a blue dashed box, where the tooltip 
reads ‘Toggles the toolbar or selected geometry  to/from constructions mode’, and click it. 

You should see that all your drawing tools now turn from white lines in the icon to blue.
You should note, at this point, that drawing whilst in construction mode is exactly the same as 
standard mode. All the tools work in the same way. However, the geometries drawn will appear 
as blue lines and, when you move back to the Part Design workbench or other workbenches, 
you won’t be able to see any construction geometry. The power of construction geometry is 
that, when you toggle back to normal geometry to draw visible parts of the sketch, you can, 
of course, attach points or constrain visible sketch edges and point to the construction 
geometry. Toggle back to normal drawing tools, and let’s work through an example to show 
this in use.

Here you can see the completed object we are aiming to make. We’ll use some construction 
geometry to help, but along the way we will also explore the ‘Create a slot’ tool that we 
haven’t used yet in this series. First, let’s draw a standard circle in our sketch. Select the circle 
drawing tool and, starting from the origin point, draw a circle. Double-check your circle is 
centred to the origin, and then use the ‘Constrain an arc or circle’ tool to set the diameter of 
the circle to 30 mm. Due to the nature of the plane origin point and axis lines, you might now 
appreciate that we have the Y axis line onto which we can attach one of our slots correctly but 
that, as there are three equally spaced slots, we don’t have geometry onto which we can 
constrain the further two slots. We can solve this by drawing two construction mode lines.

Click the ‘Toggles the toolbar or selected geometry to/from constructions mode’ once more, 
and then select the ‘Line’ tool. Click and draw a line that starts at the origin point and moves 
out at an angle to meet the edge of the circle. Do this twice, with one construction line in the 
lower right-hand quadrant of the circle, and one in the lower left.
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Next, click the ‘Fix the angle of a line or the angle between two lines’ tool, and select the 
vertical Y axis line and then the lower right-hand construction line. 
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As we want the three slots to be equally spaced, set this angle to 120 degrees. Repeat this, 
selecting the Y axis line and the lower left construction line so that we have both our 
construction lines correctly positioned.

Select the ‘Create a slot in the sketch’ tool, and make sure you have toggled the drawing tools 
back to normal mode and you aren’t still drawing in construction mode. 

Draw a slot by clicking somewhere on the vertical Y axis line and dragging down towards the 
centre of the circle, but don’t connect the sketch to the centre origin point. Notice that when 
you draw with the slot tool, numerous constraints are automatically added, and this includes 
that the slot is either vertically or horizontally constrained. Let’s fully constrain this slot. Begin 
by selecting the lower point on the Y axis line and set a vertical distance between it and the 
origin point of 5 mm. Next, select the two points in the slot that are on the centreline, and 
create a vertical distance between them of 20 mm. To set the width of the slot, select either 
set of two points that are at the end of the outer line, and mark the connecting point of the arc 
which forms the slot end. With two selected, set the distance between them as 3 mm. This 
results in a fully constrained slot with a length of 23 mm (slot length, plus the radius of the arc 
at each end) and a width of 3 mm.
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Sorting Your Slots
To draw the other two slots is slightly more complex. Draw a slot of any size in the lower left-
hand quadrant. Again, the drawn slot will be constrained to vertical or horizontal automatically, 
and so we need to delete those constraints to be able to position it on an angle. Find the small 
red horizontal or vertical dash that is the constraint. Highlight this with a left-click and delete it 
with the DELETE key. You should now be able to drag the slot into an angled position. 
To correctly place the slot following the construction line, we can use a single symmetry 
constraint. First, select two points that are at the end of the same arc forming the end of the 
slot, and then select the construction line. Next, click the ‘Create a symmetry constraint 
between two points with respect to a line or third point’ tool – this should now constrain the 
slot can now add distance constraints to bring the slot to the same relative position as our first 
slot. However, note that, due to the angle, we can’t use vertical or horizontal distance 
constraints, so we need to use the ‘Fix the length of a line or the distance between a line and a 
vertex’ tool.
Repeat the above to get all three slots fully constrained, and then close and pad the sketch to 
get the final result. Whilst this is a relatively simple example, it does show how combining 
construction geometry alongside regular geometry is a powerful sketching approach. You can 
use all the drawing tools in construction mode and, as such, there is no end to the possibilities.
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Trim An Edge
Moving away from construction mode, another really useful pair of tools are the ‘Extend an 
edge with respect to the picked position’ and the ‘Trim an edge with respect to the picked 
position’ tools, the latter of which is particularly powerful. If you have used Inkscape, the 
excellent open-source 2D vector graphics software, you probably have used the concept of 
Boolean operations, union, difference, intersection, and more, to combine different primitive 
shapes. This is similar to how, in the Part workbench, we use Boolean operations to combine 
primitive solids. It’s a feature in Sketcher that I missed at first, until I discovered the ‘Trim an 
edge with respect to the picked position’ tool.
As a simple example, let’s open a new project and again move to the Part Design workbench, 
create a new body, and then a sketch on the XY plane.
In this sketch, first let’s select the ‘Create a circle in the sketcher’ drawing tool, and draw a 
circle anywhere on the plane. Next, select the ‘Create a rectangle in the sketch’ tool, and draw 
a rectangle that overlaps the circle. If we now select the ‘Trim an edge with respect to the 
picked position’ tool, we can use this to get rid of parts of lines we don’t require. 

If you click a line that intersects another line, that line section will be deleted, even if they are 
from separate objects like our circle and our rectangle. 

Here you can see that we have deleted two line segments inside the circle that belonged to the 
rectangle circle.
We can of course also remove the line that belongs to the circle that is in between the lines of 
the rectangle in exactly the same manner. That just leaves the now disconnected line left over 
from the rectangle that is free-floating inside the circle. 
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If we now try and use the ‘Trim and edge with respect to the picked position’ tool, we will get 
an error message. The Trim tool is only of use when a line intersects or is connected to another 
line. 
If we had deleted this line first using this tool, it would have worked as it was still connected to 
the rectangle, but now this tool will fail. For non-connected lines such as this one, you can 
simply left-click on it to select it as an item and press the DELETE key.
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Extend An Edge
A similar useful tool is the ‘Extend an edge with respect to the picked position’ tool. In a new 
project and a new sketch, draw a rectangle and then draw some polylines near the rectangle 
that don’t quite meet the rectangle lines, similar to this. 

Next, select the ‘Extend an edge with respect to the picked position’ tool and left-click on one 
of the lines that doesn’t meet the rectangle. If you move the cursor, you can now extend this 
line to any position you like or, as it crosses the line forming part of the rectangle, that line will 
become highlighted meaning that you can attach the line to the rectangle at that point. 

This tool works not just on straight line geometry, but will also work to extend arcs and more.
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Image
Another slightly advanced sketching approach is the concept of sketching over an imported 
image, or images, to create some geometry that matches a real-world object. To do this we 
can use a separate workbench, ‘Image’, to import picture files to particular planes. We also can 
then scale the images correctly and more. Let’s create a new project and move to the Image 
workbench. On the Image workbench, you will see that there are three main tool icons. 

Find the tool icon that reads ‘Create a planar image in the 3D space’ and click it. 

Next, navigate to a picture file you want to import.

Final Steps
Once you select an image, you will get a dialog box asking which plane you would like to 
attach the image to. We opted for XY in the first instance. The dialog box also has an ‘Offset’ 
input box – this is the distance from the selected plane where the image is placed. It’s useful, 
when intending to trace parts of the image in Sketcher, to have the image placed slightly under 
the plane, so we added a -0.1 mm offset before clicking OK. You should now see your image 
loaded onto the selected plane and you can see an ‘imageplane’ object appear in the file tree 
view. Of course, like most items in the file tree, you can toggle the visibility of the imageplane 
item on and off using the SPACE bar.
Having imported our image successfully, we can switch to the Part Design workbench. Create a 
new body and then create a new sketch in the XY plane. 

If you imported the image with the correct negative offset, you should now see the image in 
the Sketcher workbench but with the datum lines above the image. 
To double-check, draw a shape in the sketch and make sure it appears over the image. You can 
now begin to draw and trace parts of your image using the Polyline tool. Using the M key to 
cycle through the different polyline modes, as described earlier in this article, can allow you to 
quite quickly create outline-traced sketches of quite complex items.
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Tracing imageplane objects is an excellent approach, but one problem is that images, 
especially photographs, rarely scale correctly when imported. 
If you have followed along and imported an image and traced (or partially traced) parts of it, 
as a test, select a line and click the ‘Fix a length of a line or the distance between a line and a 
vertex’ constraint tool. 
You’ll probably see that the length of the line doesn’t match the reality of the object. In our 
case, if we click the first line on the upper part of the metal blade of our shear, we get a length 
of 105 mm, which is way too big. Whilst there are ways to scale a complete sketch using the 
Draft workbench, a better approach in this instance is to scale the imageplane 
object before we do too much work with it. If we have access to the object in the image, we 
can simply measure a part of the object.

To scale our image plane object correctly, let’s hide the sketch by toggling its visibility in the 
file tree using the SPACE bar. Then, return to the Image workbench. Click the ‘Scales an image 
plane by defining a distance between two points’ tool icon and a ‘Scale image plane’ dialog box 
will appear. First, input a known distance that applies to two points on the object. So we input 
46 mm. You then click on the first point on the imageplane object, so we clicked on the point 
on the top of the blade at the fulcrum point on the shears. Next, you click the second point 
representing the other end of the distance you input. 

In our case, this is the point at which the upper blade joins the handle. Finally, the dialog asks 
you to click the imageplane object you want to scale. Then you click OK, and the imageplane 
object is now scaled correctly to the object.
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With a little forethought, we can make our image scaling process a little easier and more 
accurate. If we are creating the image ourselves, there are a couple of things we can do. 
Firstly, ensuring that our image is parallel to the object means that when we trace the 
item, we aren’t tracing a skewed version of it. Making sure a photograph is taken directly from 
above can help; or, if sizes allow, even better is to create a scan image of the object on a 
flatbed scanner. Finally, if you add a ruler or a cutting mat with a grid to the background of 
your image, you can use this as the reference points for the ‘Scale image plane’ tool for 
really accurate results.

‘M’ Hot Key
A very useful feature within the Sketcher workbench, when using the Polyline tool, is the M hot 
key. When the Polyline tool is in use, pressing the M key cycles the tool through various modes 
that are incredibly useful. To explore this in a new sketch, select the Polyline tool and draw a 
few random lines in the standard mode. 
Without right-clicking to complete a polyline, press the M key once. This first new mode 
enables you to automatically place a right angle line segment. Click the M key once more, and 
it will cycle the angle placement relative to the last polyline point. Click M again, and you can 
now draw an arc that is anchored tangentially on the last point of the line. Another M press 
changes the arc orientation, and a final M press allows you to draw an arc anchored to the last 
point, but not tangential. 
Whilst this sounds complex in description, it’s simply a case of playing with the Polyline tool 
and it soon becomes instinctive.
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Quick Tip

• The Image workbench works with lots of common file types, including SVG. However, 
you might be able to import an SVG as geometry, negating the need to sketch it!

• Most of the functions we have shown in this article work whether you are in 
construction or normal mode in Sketcher.

• When you import an image, it tends to import in an angled view. The view buttons and 
cube work exactly the same with the image plane, and pressing ‘top’ will give you a 
top-down view
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Sheet Folding

We are going to work mostly on an add-on workbench called ‘Sheet Metal’, so let’s get that 
installed. Open up FreeCAD and click Tools > Addon manager, and then scroll down the list to 
find ‘SheetMetal’. Click to install the workbench, and then close the Addon manager. You will 
get prompted to restart FreeCAD.

Once you have restarted FreeCAD, start a new project and, as a very simple first example, let’s 
first go to the Part Design workbench, create a body, and then create a sketch in the XY plane.
Inside the sketch, let’s create a rectangle around the origin point. We don’t need to fully 
constrain this sketch, but let’s give it a horizontal and a vertical constraint, making it roughly 
12cm by 6cm. Once this is done, close the sketch. 
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Without making further changes to this sketch, we can move straight away to the Sheet Metal 
workbench. In this workbench, with our sketch highlighted in the file tree, let’s click the 
‘Create a sheet metal wall from a sketch’ tool icon.

You should see that our sketch has been extruded slightly to form a sheet, and that a new 
object called ‘BaseBend’ has appeared in our file tree. Similar to if we had extruded our part, 
we can still make changes to the underlying sketch, and those will be pushed through to the 
BaseBend object. There are also numerous parameters in the BaseBend object dialog. 
Notably, you can adjust the thickness of the sheet – this is useful since the BaseBend object, 
as you will see, defines the sheet thickness for the rest of the attached design.

Next, let’s select one of the edges on the BaseBend object. We selected the upmost edge line 
of one of the longer sides. With that selected, click the ‘Extends one or more face, connected 
by a bend on existing sheet metal’ tool icon, which should be second from the left in the Sheet 
Metal workbench toolbar. 
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You should now see that we have created a new section of our sheet design, folded at 90 
degrees to the original sheet (Figure 2). 

This new object appears in the file tree labelled ‘Bend’ and subsequent bends will be labelled 
‘Bend001’, ‘Bend002’, etc. 
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Highlighting the ‘Bend’ object in the file tree, we can adjust plenty of parameters. 
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We’ll leave the first parameter, Bend Type, as it is, set at ‘Material Outside’, but have a glance 
at the options for later on. You’ll note that our new folded section is folded down from the 
original BaseBend object in the Z axis. If we wanted this section to fold upwards, we can 
change the ‘angle’ parameter in the dialog. Setting this to -90 rotates the folded section to 
point upwards. Similarly, we can set the angle of this fold to any amount we choose. Moving 
down the parameter list, we can use the ‘gap1’ and ‘gap2’ parameters to make the folded 
object not the full length of our attached BaseBend edge. 
So, for example, we have added a gap value of 10mm to each of those parameters. 

You may need to click the ‘Recomputes the current active document’ button or press CTRL+R 
to see the changes in your model.
You’ll notice that not only does the bend object reduce in length by the gap amount, but also 
that there are some small ‘relief’ notches automatically added at the end point of the bend. 
This is good practice in sheet metal work as, if you fold a bend that connects to a straight 
edge, the end of the bend will distort the straight edge at the point it joins it. Adding the notch 
stops this distortion from occurring.
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If you wanted to not have a relief notch added, you can scroll down to the ‘Parameters relief’ 
section and set the relief factor to ‘0’ and then set the ‘use relief factor’ setting to ‘true’. This 
option might be useful if you are using the Sheet Metal workbench to design using different 
materials, such as thin card or plastics.

Before we move on, please also note that, in the ‘bend’ object dialog, you can change the 
length of the added bend part. Before we add more bends, undo or delete any changes you 
have made so that we have our simple BaseBend, and our first bend object that is full length 
with no gaps, etc.

Next, let’s select one of the short edges of our BaseBend rectangle sheet and add a second 
bend to create a wall at 90 degrees. You’ll notice that at the corner where the two folds meet, 
there is a small gap. This is a by-product of working in sheet metal, where the radius of a fold 
means that folded sections stand slightly off the BaseBend object. You also may note that the 
two folds join together at a very sharp point where they join the BaseBend object. Again, in 
real life, that sharp convergence point could create distortions in the piece as it is folded, so it 
can be a good idea to add some corner relief. Corner relief is a small cutaway that, similar to 
the earlier notches, stops the metal distorting when folded. To add corner relief, we need to 
select the two edges which run into the corner on the BaseBend object. You can see these 
edges selected.

With the two lines selected, the ‘Corner Relief to sheet metal corner’ tool icon should become 
active. 

Clicking the tool should create a corner relief object in the file tree, and also create a circular 
hole in the corner of the two folds. 
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There are options for other corner relief geometries in the corner relief object dialog. Whilst a 
circular relief might be easy to create in a flat sheet design using a drill, you might prefer a 
square relief or another shape. Finally, there are also options for ‘circle scaled’ and ‘square 
scaled’ geometries. These are useful as, if we use a scaled corner relief but then add other 
folds around that corner, as we are about to do, the scaled relief is sized so that it won’t 
interfere with the subsequent fold. Therefore, after experimenting, set the corner relief to 
‘circle scaled’.

As you can see, we automatically appear to be making a tiny metal tray or lid! We might in 
real life want to create folds around the corners of the side walls to create a very rigid 
structure. If we select one of the outer edges of the shorter sides folded wall and click the 
‘Extends one or more faces’ tool again, another bend object appears and we now have a folded 
metal piece that completes the corner. 

However, this piece currently sits inside/on top of the other folded wall section. Of course, this 
would be impossible to make, so we need to use an offset to place this fold correctly.
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Add An Offset
Highlight the Bend object in the file tree and, in the dialog, click the drop-down menu for the 
‘Bend Type’ option. Select ‘Offset’, and now the new fold will be offset by the amount specified 
by the ‘offset’ field further down the dialog. Our material is 1mm thick, so if we change the 
offset amount to 1mm, the new section is on the outside of the two tray walls. 
Or, if we input -1mm, then the fold sits on the inside of the walls. Whilst this works, it does 
mean that our material touches inside the folded overlapping sections. This becomes an issue 
later in the process when we want to flatten our design, as it requires a clearance between 
folded surfaces. Therefore, set your offsets to 1.1mm to create external folds with a small 
clearance. Having created all the parts to make one corner of our metal tray, we can continue 
around the BaseBend object, adding further folds and corner reliefs until we have four walls 
with folded corners.

One interesting thing to note about designs made this way on the Sheet Metal workbench is 
that they can still be manipulated and worked on by tools on other workbenches as normal. 
One quick example is to move to the Part Design workbench, select a suitable edge, and apply 
a chamfer or a fillet. A more useful example is to perhaps add sketches to our metal tray 
design. If we were to fabricate this tray, we might like to add holes in the design for bolts or 
rivets to fix the folded corners firmly. To add a sketch to this design, you work exactly as if you 
were adding a sketch to any face in any design. First, move to the Part Design workbench and 
select one of the external folded tab faces and click the ‘Create a sketch’ button. We then drew 
a 2mm radius circle, imagining we might use a 4mm diameter rivet. Again, just like any sketch 
on a face, we used the ‘Create an edge linked to an external geometry’ tool to be able to 
position our circle relative to the end of the folded tab.
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Closing the sketch, we then used the pocket tool on the Part Design workbench to create a 
hole, and selected ‘through all’ as the type so that the holes would be created on both sides of 
the design. Whilst we could have done this in a single sketch, we added another sketch to 
create the same holes at the other end of our tray.

To fabricate an object, such as our tray created from a folded sheet, we need to be able to 
flatten our design back out after we have completed it. 
Flattening and unfolding the design then allows us to see the basic shape of the flat sheet that 
we need to cut to create our object. To flatten the design on the Sheet Metal workbench, we 
need to select a face which will be the reference plane to flatten the part to. With our metal 
tray design, the obvious choice is to pick the outer large surface of the BaseBend object. With 
that face highlighted, you then need to click the ‘Flatten sheet metal folded object’ tool icon, 
which is fifth from the left on the Sheet Metal workbench toolbar. You should now see a dialog 
box appear, titled ‘unfold sheet metal object’.
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You may also see that the report window opens at the bottom of the screen with a report that 
‘engineering mode is not enabled’. Don’t worry about the report window message: just close 
the report window. In the dialog box, make sure that ‘generate projection sketch’ is ticked and 
then also tick the ‘Manual K-Factor’ box. When you tick that box, you will need to input a K-
factor value. We read that an 0.4 ANSI value was appropriate for our 1mm thick sheet metal 
design when working in aluminium. 
Having input 0.4 and ticked ‘ANSI’, we can then click the ‘OK’ button. Depending on your 
computer, it may take a few moments but, once processed, you should now see two new 
objects in the file tree view – ‘unfold’ and ‘unfold sketch’. These two new items exist outside of 
the active body containing our folded design. So, to tidy the file tree view, we can close the 
drop-down menu of the active body so that our file tree just has three visible list items: ‘Body’ 
and the two new unfolded items. You can also see in the preview window our two new items: a 
blue line sketch and a semi-transparent unfolded sheet of our design. Toggling off the Body 
item, using the space bar, in the file tree means we can inspect these items more clearly. Of 
course, like most objects, we can change the appearance and position of these items.

Numerous Uses
We can use these items in numerous ways. For example, we might use the ‘Unfold’ object to 
be the basis of an engineering drawing by pushing views of the object through to the TechDraw 
workbench and adding dimensions and coordinates. This is useful if you needed to traditionally 
mark or scribe a layout onto sheet metal. You could also make only the sketch item visible, 
and then highlight it and use File > Export to export a variety of file types (DXF, SVG, and 
many more) to create printable plans, or to use to create G-codes for a milling machine or to 
cut on a laser cutter.
Whilst there is a lot of mileage in what we have looked at so far, there is the fact that 
everything we designed in our tray example was a fold that started or extended from an 
existing edge of an object. 

Let’s look at using sketches to create fold lines that are not on the edge of items but inside the 
face of a sheet. To begin, we create a new project, move to the Part Design workbench, and 
create a sketch in the XY plane. In the sketch, we draw a similar object.
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Moving back to the Sheet Metal workbench for a moment, we selected our sketch and clicked 
the ‘Create a sheet metal wall from a sketch’ tool icon again to create a basic BaseBend object.

Notice that, similar to padding or extruding a sketch, this tool acknowledges that internal 
geometry is going to be a void. 
Next, we want to create some further sketches that will act as folding lines for our project. 
Let’s aim to fold each side wing twice at 45 degrees. Move again to the Part Design workbench, 
highlight the upper face of our BaseBend object, and create a sketch on it.
For our first fold sketch, we drew a vertical line across one of our wings 15mm in from the 
edge, which we imported using the ‘Create a linked edge’ tool. Once this single line was set up, 
we closed the sketch and returned to the Sheet Metal workbench.
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To create this fold, you first need to select the face where the sketch is attached on the 
BaseBend object in the preview window. This feels a little counter-intuitive and we naturally 
would select the whole BaseBend object in the file tree, but this doesn’t work. With the correct 
face selected, hold the CTRL-key and click the sketch in the file tree. With these two items 
highlighted, you should now see that the ‘Fold a wall of metal sheet’ tool becomes visible. 

Click this tool icon and you should see a 90-degree bend appear in your part at the sketched 
line, a ‘fold’ item appears in the file tree, and the sketch should be toggled to not visible. 
Highlighting the fold item, you can then use the dialog to make changes – we set our 
fold to 45 degrees.
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Summing Up
For our next fold, we again used the Part Design and the Sketcher workbench to create a 
sketch containing a line that went across the ‘wing’ at the point it connected with the circular 
centre section of our object. Again, we created edges linked to external geometry to be able to 
draw the line precisely at those points. Moving back to the Sheet Metal workbench, we again 
selected the upper face of the object and then selected our sketch containing the fold line. 
Applying the ‘Fold a wall of sheet metal’ tool, we again set the fold angle to 45 degrees and, 
this time, we also changed the ‘position’ to ‘backwards’ as this meant the radius of the fold lay 
outside the flat area of the circle rather than inside it. 
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Fold Geometry
When you fold sheet materials, including sheet metals, there are numerous forces in play 
inside the fold. On the inside of the fold, the material is under a compression force and, on the 
outside of the fold, the material is being expanded. In the diagram below, the dotted green line 
represents the line through the material where these forces swap from compression to 
extension and vice versa. This line is called the neutral axis. In different materials and at 
different thicknesses of materials, this line will be in different positions. The reason this is 
important is that it dictates where fold lines are accurately placed to create the overall 
dimension of a piece accurately. The position of the neutral axis is given as a ratio of the 
material’s thickness; this ratio value is called the K-factor. You can search online for the K-
factor of a given material at a given thickness, but also be aware of what industrial standard 
the K-factor value is being stated in, either ANSI or DIN. We found that a K-factor ratio of 0.4 
ANSI was commonly given for 1mm aluminium sheet. Using this value when using the ‘Flatten 
sheet metal folded object’ tool will ensure that all your fold geometry is accurate for the 
material you wish to use. 

Quick Tip
When creating sketches that will act as fold lines, you need to create each line in a separate 
sketch, as you will need to adjust fold parameters individually.
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Frames And Pipes

Here we will be looking at the ’Dodo’ workbench, which treats working with framed objects and 
designs or pipework.
To begin, open FreeCAD and click the Tools > Addon manager, then select “Dodo” on the list. 
Click install. When installed, you will be prompted to restart FreeCAD. Restart FreeCAD and 
then create a new project. Let’s look at making a framed object first. 
To begin, move to the Part workbench and use the ’Create a Cube Solid’ tool to create a cube 
that is  750 × 750 × 500 mm.

Next, let’s move to the Dodo workbench, which is listed as ’Dodo WB’ in the workbench drop-
down menu. Click the ’Open FrameBranch Manager’ tool, 

and you should see a dialog box similar to the one shown. 
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To create a frame, we need to select a profile for the frame extrusions. There’s a collection of 
preset profiles included that model real-world standard metal extrusions. Let’s select a simple 
40 mm × 40 mm square extrusion with a 5 mm wall thickness. Click the drop-down menu that 
currently reads ’IPE’ or ‘HEA’ and select ’RH’, and then select the ’RH40×40×5’ by highlighting 
it in the list below. Make sure to give it a name Eg: ‘MyFrame’

Next, click on any edge of the cube in the preview window and then click ’OK’ in the Open 
FrameBranch Manager dialog box. You should now see that every edge of the cube object has 
had the 40 mm × 40 mm extrusion added to create a frame. 
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By selecting the ‘Model’ tab, you can, of course, in the file tree view, make the cube object 
invisible to get a better view of our frame.

You’ll notice that our frame has all the required sections but that they all overlap at the 
corners. We need to extend or trim these frame parts to make a frame that could be fabricated 
in real life. With the Open FrameBranch Manager still open, we can use the ’Get Targets’ and 
’Trim/Extend’ buttons to help us do this quickly. 

First, select an inside face of one of the frame sections and then, holding down the 'Control'-
key, select the opposite inside face – with both of those selected, click the ‘Get Targets’ button. 
We have now defined the reference as to where we want to trim or extend other frame 
structure objects. 

Next, select any face of a frame piece that crosses the target faces that we want to trim to 
between the target faces. Click the ‘Trim/Extend’ button and you should see that our cross 
member now is shortened to directly fit inside the other pieces. We don’t need to select new 
targets to also trim other frame pieces to the same length. Even the piece below the trimmed 
piece can be trimmed. We can select faces on the three other pieces and click the 
‘Trim/Extend’ button to bring them all to length. You can also, when required, select the 
outside edge faces of objects as targets, and the ‘Trim/Extend’ button will extend pieces to the 
correct length.
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It’s worth noting that although we have used a solid object as the basis of our frame, we can 
apply frame structures directly to sketches. As a quick example, create a new project and 
move to the ‘Part Designer’ workbench and create a sketch that has a rectangle with an extra 
line spanning across the rectangle inside – our rectangle was 1000 mm × 500 mm, in the XY-
plane. Note that you might need to click ‘Fits the whole content on the screen’ to view the 
retangle. 
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Moving to the “Dodo” workbench again, click to launch the ‘Open FrameBranch Manager’. Let’s 
select a different profile – we went with ’IPE80’, which is a common steel I-section 
used in buildings and structure fabrication. 
Again, click any edge of the sketch in the preview window and then click ’OK’. You should now 
see a frame appear made from the I-section.
You might need to turn the beams 90°. Select every beam by clicking any surface of it, using 
the ‘control’-key and typing 90 in the field next to the dial button.

You can, of course, use any face of any of the IPE80 parts to set targets again to trim or 
extend other sections to. 
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Interesting Intersections
So far, we have made frames with frame members at 90 degrees to each other. Of course, it’s 
possible to create frame structures around sketches or paths with other angles in them. 
However, we need to use some workarounds if we want to create accurate and neatly trimmed 
intersections. As an example, let’s create a rectangular object with a large 45-degree plane on 
one end to create a frame around.
In a new project, open the ‘Part Designer’ workbench and create a new sketch in the XZ plane. 
Create a sketch similar to this.

In this example, it’s probably useful to fully constrain your sketch so that we know accurately 
where frame elements will be placed. 
Next, pad the sketch to 250 mm and extrude the sketch into a large frameable object.

Moving to the ‘Dodo’ workbench, once again open the ‘FrameBranch Manager’ dialog and 
create a frame on our object in the usual way – we opted again to use the RH 40 × 40 × 5 
square box profile. When you initially create the frame, you’ll notice that the angled sections 
need to be extended to fully meet the vertical and horizontal sections. If you then select 
targets and Trim/Extend, you’ll see that the angled section now extends through the other 
sections with some excess material. 
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Removing Overlaps
Continuing to ‘Trim/Extend’, we can get the horizontal and vertical frame members to adjoin 
correctly, as seen in figure above. Now we are ready for our workaround solution for the 
angled parts. Basically, the idea is to create parts that cover all the material we want to 
remove and then, using the ‘Part’ workbench, we can use ‘Boolean cut’ operations to remove 
the unwanted overlap sections. There are, as ever in FreeCAD, numerous ways we could 
achieve this. We could, for example, create simple solid cuboid objects on the ‘Part’ 
workbench, move them into place, and then perform the cut operations.

Another, perhaps cleaner, approach is to map a sketch onto the frame to create an extrusion 
that matches the material we need to remove and then perform the cut operation. Select the 
outside face of one of the short upright frame sections, then, on the ‘Sketcher’ workbench, 
create a sketch. 
When prompted, choose ’FlatFace’ as the sketch attachment method. In the sketch, use the 
’Create an edge linked to external geometry’ tool to import any edges and vertices that will 
help you create your sketch. 

Then, use the Polyline tool to create a sketch that will remove all the material you need to 
remove from your target frame section.
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Next, close the sketch and move to the ‘Part’ workbench and extrude the sketch you just 
created. Extrude it in such a way that it moves through the frame element you wish to cut 
material from. For me that is -40 mm. 
You can only perform a cut operation using two parts, so the next step is to select one of the 
angled frame members from inside the Travatura folder in the file tree and then select the 
extrusion we just made. Click the ’Make a cut of two shapes’ tool. 
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This should perform the correct cut on one of the angled frame members. Next, select the 
other frame member you wish to cut excess material from and then select our extrusion 
object, which now can be found inside the ’Cut’ object folder that was just created in the file 
tree. 

You can see that this has worked perfectly and has given us the frame member arrangement 
that we wanted to achieve.
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The ‘Dodo’ workbench doesn’t just have excellent tools for creating framed designs, it also has 
a collection of tools for making pipework designs easier to realise. Like many aspects of 
FreeCAD, it’s incredibly capable, but we can start with some simple examples that you can 
build on as you explore the tools. 
In a new project, let’s start by making a sketch in the XY plane. We created a simple square U 
shape using the ‘Polyline’ tool. We made it a reasonable size, 300 mm x 500mm, because, if 
it’s too small, when we add pipes following the sketch, it might fail if the pipe corners can’t fit 
in the dimensions of the sketch. It’s worth noting that pipe and frame objects on the ‘Dodo’ 
workbench can be applied to not just sketches but also wires created using ‘Draft’ tools, or you 
can simply add pipe objects onto other existing pipe objects.
With a sketch created, move to the ‘Dodo’ workbench and click the ’Open PypeLine Manager’ 
tool icon.

In the ‘PypeLine Manager’ dialog box, there’s a range of standard pipe types to select from – 
we chose the ’DN40’ pipe from the ’SCH-STD’ group. 
This is a common pipe dimension with a 40 mm internal diameter. Next, click any part of the 
sketch in the preview window and then click the ’Insert’  button in the PypeLine Manager 
dialog. This should automatically create a pipe that follows the complete sketch path with the 
90-degree curved sections added.

We mentioned earlier that you can add pipe objects and other peripherals by simply attaching 
them to an existing pipe. There are numerous tools that help us do this. Selecting the outer 
edge of one end of our U-bend pipe construction, click the ’Insert a Reduction’ tool. 
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The larger end of the reduction is automatically defined by the diameter of the selected 
adjoining pipe, and so we simply use the ’Insert Reductions’ dialog to select the smaller end of 
the reduction. You can see we opted for the ’DN20’ size, and then clicked the ‘Insert’ button to 
add the reduction.

It’s as straightforward to add a simple length of straight pipe to an existing design. Again, 
select the edge of the thin end of the reduction we just added and click the ’Insert a Tube’ tool.

In the dialog box, select the tube type that matches the diameter of the reduction (DN20) and 
then type a dimension into the length input box to set the length of the tube you require.
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Finally, click the Insert button to insert the tube. Similarly, we can add a curved section or 
’elbow’ into the design using the ’Insert a Curve’ tool. 

When inserting a curve, you select a target edge as before and then select a matching tube 
profile – again, we chose DN20. You then need to add a bend angle and a bend radius into the 
input boxes. Starting with values of 90 for each gives you a good result – you can experiment 
with other values. A small issue with this is that it’s easy to input values that can’t actually 
exist and therefore won’t work! Once you have your values and options selected, click the 
Insert button to insert your curve. Finally, with the ’Insert Elbows’ dialog, you have a dial 
wheel that you can adjust to change the angle of the curved elbow you have just added. 

Often pipework uses flanges as joining mechanisms between pipe sections, and as such, the 
‘Dodo’ workbench has a ‘Flange’ tool. At the other end of our pipe experiment, we selected the 
outer edge of the pipe end and clicked the ’Insert a Flange’ tool. 

There are various flange standards in the dialog box – we selected a DN40 type to fit our 
existing pipe edge. We then clicked Insert to add the flange.
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We’re sure by now that you have the general idea, but it’s worth exploring the other tools 
available to manipulate and create pipe systems. There are tools for adding valves of differing 
types, U bolts to secure pipes to other structures, tools to cap the end of pipes, and tools to 
create flowing branches in pipes. There really isn’t much you can imagine that you couldn’t 
design using these tools. 

Finally, it’s also worth exploring how you could add to designs using the workbenches we have 
looked at previously. When adding flanges, for example, it would be quite straightforward to 
use the ’Fasteners’ workbench to create nuts and bolts to join flanges together. We looked at 
the Fasteners workbench as part of the tutorial working with assemblies.

Extrude A Sketch
You might have noticed that within the ‘Open FrameBranch Manager’ dialog, there is the option 
to select ’<by sketch>’ in the drop-down menu where you select the different profile families. 
This is a really useful feature that allows us to draw a custom profile for extrusion into frame 
elements as a sketch. 
However, there is a particular rule that we need to follow when drawing a sketch for it to work 
correctly. The rule is that you need to draw your profile with the ‘Polyline’ tool, and you need to 
draw the polyline in an anticlockwise orientation. In a new project, create a sketch on the XY 
plane and draw a simple profile shape using the ‘Polyline’ tool. Remember, you can change the 
behaviour of the ‘Polyline tool’ using the M key on your keyboard, and it’s possible to create 
profiles with arcs and tangent lines as long as you create the profile moving in an anticlockwise 
direction in the sketch. For good practice, you should fully constrain the sketch. However, for a 
simple test sketch profile, it isn’t necessary. Once you have a profile sketch created, you can 
test it by first moving to the ‘Part’ workbench and creating a large cube to use as a target for a 
frame and then moving to the ‘Dodo’ workbench to create the frame. When selecting the 
profile for the frame, click the drop-down menu and select <by sketch>. You should see your 
sketch ’sketch’ listed in the dialog box. Select that, and then select an edge of the cube, and 
click OK as we have done before. You should see a frame created using your sketch profile. If 
you’ve accidentally created a sketch in which the polyline isn’t moving in an anticlockwise 
direction, you will probably still see some frame elements, but they won’t follow the edges of 
the cube and will extrude in random directions.
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Getting Going with Gears

Gears are all around us. These clever interlinking drive systems underpin many mechanical 
wonders, but they have always been quite difficult to make. With modern maker tools like 3D 
printing and laser cutting, they are now commonly available and customisable for you to 
explore and use in your projects. 

Gears come in many different sizes and flavours, but they are often used for the same small 
number of tasks. These uses include increasing or decreasing the speed of a system, 
increasing or decreasing the torque or power of a system, or changing the direction of rotation 
or direction of thrust. It’s fair to say that you can deep-dive gear geometry and theory and find 
there is no end of stuff to learn. In this tutorial, we’ll skim the surface so that you will know 
enough to get started.

Inkscape is a powerful free and open-source vector graphics application, and it’s packed with 
excellent tools to aid all manner of making. Bundled into Inkscape are a collection of 
extensions that are incredibly useful add-on features includingt a gear generator. Clicking 
‘Extensions > Render > Gear > Gear’ you’ll see a pop-up window into which you can input data 
to create a gear. 

First, check that the Units option is set to ’mm’, then you can experiment with ’Number of 
teeth’ and the size of the tool using ’Circular pitch (tooth size)’. The pop-up also neatly has an 
option to include a hole in the centre of the gear, as you’ll often want to mount it on some kind 
of shaft. We’ll talk about the ’pressure’ or ’contact’ angle elsewhere in this chapter, but for now 
it’s a good idea to leave it set to the default 20 degrees.

Once you have some settings in the gear generator pop-up, you can click ‘Apply’ and it should 
draw a gear perfectly on your canvas. The gear generator pop-up doesn’t close after applying 
and creating a new gear. This means you can repeatedly make more gears with different 
values. 

Note: If the first gear you render is quite small, it might appear behind the gear generator 
pop-up!
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You can see that we have made a collection of gears, all of which have the same tooth size so 
should be compatible.

You can also see that we have made a ’rack gear’ section. Rack gears are where a small 
traditional round gear (pinion) engages with a long flat-toothed gear (rack). These rack-and-
pinion gear systems can be used to create horizontal movement, with the pinion gear 
remaining in position and the assembly attached to the rack moving side to side in a linear 
fashion. If you click ‘Extensions > Render > Gear > Rack gear’ you’ll see a pop-up dialog to 
create a section of rack gear teeth. In our installed version of Inkscape, we found that we 
needed to set the tool spacing to double the amount of our tooth height when creating a 
standard gear to create a matching rack section. So, for the gears that we generated with 20 
mm teeth, we needed to set the tooth spacing to ’40’. Again, leave the ’contact angle’ set at 20 
degrees and set the length of rack you want to generate. Click ‘Apply’ and you should see the 
length of rack gear teeth appear. It only generates the teeth, so you can use the regular 
drawing tools to turn the rack line into an object for your rack gear project.
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The great thing about using a laser cutter to cut gears generated in Inkscape is that you can 
also add details onto the gears that can be engraved. In our set of gears, we have engraved 
the number of teeth to each gear so that we can easily identify which gear is which. 

Finally, to complete our gear set, we created a backplate that had two 4 mm wide slots which 
would allow us to bolt our gear wheels to the board and slide them into various positions. A 
useful concept to understand is gear ratios. 
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When talking about gear ratios, it’s common to consider which gear is ’driven’ and which is the 
’driver’. The driver gear is the gear connected to something that makes it turn, for instance, a 
motor, engine, rubber band, hand crank, windmill, ... Sometimes, instead of ’driver’ and 
’driven’, you might hear the terms ’input shaft’ and ’output shaft’ – again, with the input shaft 
being the mechanism connecting the driver gear to a rotational source. The gear ratio, when 
we consider two gears, is defined as the number of teeth on the driver gear connected to the 
input shaft divided by the number of teeth on the driven gear connected to the output shaft. 
So, as in picture above, we can see that the driver gear is a smaller 10-tooth gear, and the 
driven output gear is larger with 40 teeth. This creates a ratio of 4:1. Therefore, the smaller 
gear has to turn four times for the larger gear to make a single revolution.
With gears connected similarly to our example, there is also a change in revolution frequency 
between the input and the output gear, and so the larger gear will rotate more slowly than the 
smaller gear. Again, this is proportional to the gear ratio, so if, for example, the smaller input 
gear is driven at 80 revolutions per minute (rpm), the output gear will rotate at 20 rpm.  
There is also a change in torque when gears are combined. You may understand this 
instinctively if you have ridden a multigear bicycle – changing the front gear to the small cog 
and the rear-wheel gear to the large cog enables you to ascend a steep hill more easily. Using 
our example of the 40-tooth and 10-tooth gear, if we imagine that we have some kind of crank 
or motor attached to the smaller gear that is inputting a torque of 1 newton, then using the 
above equation we can see that the output torque would be 4 newtons.
You’ve probably noticed a small difference between our directly coupled gears and our bicycle 
discussion. In our example, the direction of rotation is opposite between the gears, so if the 
input gear is rotating clockwise, then the output gear is anti-clockwise. If we need gears to be 
directly coupled and want to maintain the direction of rotation at both the input and the 
output, we need to add an extra gear to the ’gear train’. Using our laser-cut gears, we can 
achieve this by adding an extra shaft and placing a middle gear. Another reason to add an 
extra gear to a gear train can be that you can reduce the size of the system when you require 
a large gear ratio.
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For example, if we want a ratio of 120:10, which can be simplified to 12:1, we could use a 10-
tooth gear and a 120-tooth gear. 

However, that 120-tooth gear will be physically quite large, and we might want to reduce the 
size. We could consider a 60:5 ratio, but, as a rule of thumb, gears with less than ten teeth 
begin to run not quite as well as their larger counterparts.
Crucially, adding an extra gear doesn’t change the gear ratio overall, and while you can check 
this simply by looking at and rotating gears, you can also see why in the maths. If we stick 
with a 10-tooth input gear and a 120-tooth output gear but place a 30-tooth intermediary 
gear, we can calculate the overall gear ratio by multiplying the two ratios made by the three 
gears. 

First we have the 10-tooth gear and the 30-tooth gear, making a 30:10 ratio. Then we 
have the 30-tooth gear and the 120-tooth gear, making a 120:30 ratio. To check the overall 
ratio, we need to multiply these two ratios together which looks like this (30/10)×(120/30). 
This returns a value of 12, which could be written 12:1, the same as our original 120:10 ratio.
While we have created a system where the input and output gear now rotate in the same 
direction, we have added a gear to our already large gear train, making it even bigger. 
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We wanted to reduce the size of the mechanism. We can achieve this by using a compound 
gear system, where the middle gear is actually two gear wheels joined together. Continuing 
with our 120:10 example, when we added the 30-tooth gear, we had a 120:30 ratio on the 
output side. We can simplify this ratio or fraction and identify smaller gear combinations 
that will give the same ratio. For example, the 120:30 ratio could simplify to 60:15 or 40:10. 
Using our first simplification means we could create a gear train where we attach a 15-tooth 
gear onto the 30-tooth gear of our 30:10 ratio pair, forming a compound gear, and then swap 
the 120-tooth gear for a 60-tooth gear. Again, if we check the maths, we have 
(30/10)×(60/15) which returns our expected result of 12. 

As you can see, a 30:10 to 60:15 compound gear train is much more compact than our 
original idea of a 120:10 would be.

When you start to create gear trains, or you begin to consider using gears that aren’t 
traditional flat involute gear wheels, you may consider 3D printing as a method to produce 
gears. 

Similar to Inkscape, there are free and open-source pieces of software to help you generate 
3D models of gears. 
Brilliantly, FreeCAD also has an add-on workbench that makes designing gears really easy. Go 
to the Addon manager in the Tools drop-down and then search the list for ’FCGear’. Install this 
workbench and restart FreeCAD. 
In a new project, move to the Gear workbench and you will see a collection of nine yellow 
icons that represent different types of gears you can create. 
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First, let’s quickly make an involute gear wheel similar to the ones we created in Inkscape. It’s 
incredibly simple to get started. Simply click the ’Create an involute gear’ option and a gear 
will appear in the live preview and as an item in the file tree. 

In the lower window of the combo view, you can see and edit the gear properties. Gear 
properties are numerous and can get complex quite quickly – many books have been written 
on the subjects of gears! To get an idea of the working parameters, it’s worth looking through 
the FreeCAD documentation on the Gear workbench as it provides a good overview. A page 
specific to the involute gear properties can be found here: 
https://wiki.freecadweb.org/FCGear_InvoluteGear

To create a variety of involute gear wheels, we can apply some changes. Scrolling down the 
properties, we can change the number of teeth using the ’teeth’ option. Changing the number 
of teeth automatically calculates the new diameters and dimensions of the gear. We can 
change the height of the gear using the ’height’ option to make a thicker or thinner gear. 
Lastly, we have found that it can be useful when 3D-printing gears to increase the ’clearance’ 
property from the default 0.25. We found increasing the clearance to 0.4 made our 3D-printed 
gears mesh a little more easily.

We have made a 25-tooth gear that is 7 mm tall. Notice that we have created this inside an 
active body that we set up on the Part Design workbench. 
This means we can add to our gear using the Part Design workbench tools. In simple ways, we 
can add a hole for a shaft through the gear, but 3D design and printing allow us to experiment 
with attaching gears to other parts of designs. 
For example, we have connected our 25-tooth gear directly to a simple wheel hub design. 
Printing this is relatively straightforward, especially if we compare he process to creating this 
part in metal using lathes and milling machines and indexing tools.
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The Gear workbench allows us, with only basic gear theory, to explore other families of gears. 
The bevel gear, or a pair of bevel gears, is a great example of a gear system that can create a 
change in the direction of work or thrust. It’s easy to create. 
Again, in a new project, simply click the ’Create a bevel gear’ tool. Similar to the involute gear, 
we can make changes to the design using the object properties. We have created a 5 mm tall, 
20-tooth bevel gear with a clearance of 0.4. We again created this inside a body so that we 
could add a sketch to pocket a hole through the centre of the gear to receive a shaft. 

Printing these small bevel gears is quite the torture test for your 3D printer. We printed them 
in PETG, and as the gear narrows to the upper surface, it’s tricky to tune the print to not 
get small amounts of stringing in between the teeth. However, with a little light work with a 
needle file after the print finishes, it is possible to get a well-meshing pair. As an example of 
using two bevel gears to change the direction of thrust, we made a quick rubber-band-
powered vehicle using some lightweight carbon fibre rods and some further 3D-printed 
housings.

Worm gears are another interesting example of changing the direction of thrust when driving 
another gear. A more correct pairing for a worm gear is a ’worm wheel’, which appears like a 
regular involute gear albeit with a curve cut into the gear teeth. A worm wheel is a tricky gear 
to generate, but you can create reasonable worm gear and wheel examples using a regular 
involute gear wheel. Worm gears are a type of helical gear where each tooth is a helix 
wrapping around the length of the gear. If we click the ’Create a worm gear’ icon, we will 
create the default worm gear. The default worm gear has three teeth, or, as it’s hard when 
looking at a worm gear to discern the separate teeth, they get referred to as ’starts’. 
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This makes sense when you look at the flat end of the worm gear and you can see that there 
are three lobes which are the start of each tooth helix. In terms of gear ratio, they work in a 
similar way to involute gear wheels. A three-start worm gear coupled with a 24-tooth involute 
gear will create a 24:3 or 8:1 ratio. 
Another interesting aspect of worm gears is that they are often referred to as ’self-locking’. If 
you set up a worm gear driving an involute gear wheel, you will find that if you try and turn 
the involute gear, it will lock and not move the worm gear; compared to other systems where 
you might need to leave a system powered or apply a mechanical brake, this can be a useful 
feature.

As ever, we have merely scratched the surface of both the FCGear workbench and gears 
generally. FCGear is capable of creating many variants of gear, and also timing pulleys, the 
type of which are commonplace on belt-driven 3D printers and other CNC machines. It’s 
certainly worth clicking each of the ’Create a gear’ icons on the Gear workbench and having a 
play with some of the parameters. There is a wealth of information online about gear 
geometry, construction, and theory of use, and while it’s a fascinating subject, it can at times 
be a little overwhelming.

Page 200 of 212



Pressure Angles
We’ve mentioned the ’pressure angle’ or the ’contact angle’ when talking about gears a couple 
of times, but what does it actually mean? In the image below, you can see two gears that are 
meshed together, and we can imagine one is driving the other. The forces exerted by the input 
gear are transmitted through the gear teeth along an angled line defined by the geometry of 
the gear. If we draw an imaginary horizontal line that is tangent to the gear circles, then the 
pressure angle is the angle between this line and the line displaying the force. Without delving 
deep into the complex maths and geometry underlying this, pressure angles are commonly 20 
degrees, as this offers a good balance of efficiency in force transmission, minimised pressure 
on bearings or shafts, and generally produces least wear on a gear.

Quick Tip

• Don’t have access to a laser cutter? You could make larger gears by printing the gears 
onto paper, gluing them to wood, and using a bandsaw or fretsaw to cut them out

• Input torque × gear ratio = output torque. Sometimes referred to as ‘torque at the 
wheel’.
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Finally

We thought it might be a good idea to look at some areas that you might like to explore now 
that you have a good grasp of the basics. You probably have some intermediate skills if you 
have followed through this series fully, so let's look at other areas of FreeCAD that you might 
explore.

For the sake of consistency throughout this series, we have used FreeCAD in its most default 
appearance – this makes it easier for people to recognise where tools are from the images etc.
However, it’s possible to change up the theme and even change the user interface entirely. For 
simple changes of theme go to Edit > Preferences and then click the General tab. You should 
see options to change the ‘stylesheet’, as well as options to change the size of the toolbar 
icons. 
Here we have changed the stylesheet to ‘Darker Orange’, and increased the tool size to 
medium.
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For a more significant change, you might like to try a different user interface. This can be 
achieved by installing the ‘ModernUI’ workbench from the Tools > Addon Manager menu. You’ll 
be prompted to restart FreeCAD and will be rewarded with a different UI where one of the 
major differences is that the workbenches are tabbed across the top of the screen, allowing for 
quick switching. 

If you don’t like the ModernUI, you can uninstall it in the usual way using the Addon manager 
but, additionally, you need to create and execute a macro to return to the original FreeCAD UI. 
This is straightforward to achieve – you select and copy the macro script text that is supplied 
in the description of the ModernUI workbench in the Addon manager. Then, from any 
workbench in FreeCAD, click the Macro drop-down. In turn, click Macros and, click Create. Give 
the macro a name, eg. restore and paste in the macro script copied from the Addon manager.  
Click the Macro drop-down and hit Execute macro window. After restarting FreeCAD, you’ll 
have returned your installation to the original state.

Whilst on the subject, macros in FreeCAD can be incredibly useful. If you have regular tasks 
that you do repeatedly, or similar objects that you create across a range of projects, a macro 
may help to streamline your workflow. You don’t have to script a macro by hand either, you 
can create macros using the record function. Essentially, once a macro is recording, it builds a 
script of all the actions you perform until you stop the macro recording. You can then save and 
name the macro, and execute the macro whenever needed via the macro menu. A simple way 
to try this is to create a new sketch and then start the macro recorder. Draw a couple of circles 
and constrain them, and then perhaps Pad them using part design, and then stop the macro. 
You can look over the script and execute it to repeat the same task. Often macros require a 
little editing and tweaking.
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We’ve come to the opinion, whilst exploring FreeCAD, that it really is unique as a CAD 
environment and we love that it isn’t trying to be an open-source clone of another tool. This 
becomes really clear when you look at the range of workbench environments there are for 
FreeCAD. There are so many we haven’t explored as part of this series, but we wanted to 
highlight a few examples that you might like to go on to explore.
Perhaps the most obvious one we haven’t looked at is the Arch workbench which is built into 
FreeCAD, usually at the top of the workbench list. Arch is short for Architecture, and it’s chock-
full of useful tools to help you design buildings and structures. Whilst you may well need to 
look through the wiki page or find an online tutorial, you can quite quickly get going with this 
fabulous workbench. 
We can drawn a simple rectangle using the draft tools in the Arch workbench, and then used a 
tool to generate a wall from the wire outline. We’ve then used the built-in tools to simply click 
and add preset windows and doors in our simple structure. Check out some of the amazing 
structure designs in Arch on the FreeCAD forums to get properly inspired.

The Robot workbench is perhaps a great example of just how powerful a tool FreeCAD can be. 
Whilst the Robot workbench is still included in FreeCAD, it isn’t being particularly actively 
developed, but it’s a fun workbench to play with for a few minutes. Often, with many 
workbenches, the FreeCAD wiki has a succinct tutorial to work through to get you up and 
running with the basics of the bench. The Robot workbench is no exception, and working 
through the instructions at https://wiki.freecadweb.org/Robot_tutorial, you can import an 
industrial robot arm. 

We used a Kuka IR500, and you can create trajectories to move the arm through, which then 
can be played like a script. If you happen to own or have access to a Kuka robot arm in real 
life, you can even export the subroutines you create to run on the machine.

The Path workbench is FreeCAD’s main CAM environment, and is where you can set up CNC 
routing and milling toolpaths to create parts on a wide variety of machines. We wrote about 
the Path workbench. Of course, FreeCAD has developed a lot since then and the Path 
workbench, with its amazing dedicated developers, is one of the most actively developed areas 
of FreeCAD. As such, it’s changed somewhat since our write-up, but there’s plenty of 
information about it online. It’s definitely worth exploring, and offers robust and powerful CAM 
approaches, and is capable of creating G-codes post-processed to suit a wide variety of 
machines.

The FEM workbench enables complex analysis of objects under loads, and this type of FEM/FEA 
approach often is quite expensive to perform in other proprietary CAD environments. It 
requires a couple of extra external packages to be installed/configured, and then models can 
be assigned material properties and then tested under loads. To get a fleeting appreciation of 
what this looks like, even without installing the extra packages, you can open one of the 
example projects bundled into FreeCAD on the FEM workbench, and see the type of 
strain/stress analysis and representation you can achieve.

When we looked at the Mesh workbench, we needed to have another CAD environment, 
OpenSCAD, installed on our machine to enable some of the Mesh workbench features. 
There’s also, however, a dedicated OpenSCAD workbench within FreeCAD. OpenSCAD differs 
from many CAD packages in that it is script-based. This means you ‘code’ your CAD models. 
For example, to make a cube in OpenSCAD, you might write a line that looks like 
‘cube([10,10,10],true);’ which creates a 10 mm cube centred around the origin point. The 
addition of a dedicated OpenSCAD workbench means that if (as we did) you have used 
OpenSCAD and are moving to FreeCAD, any components or models you have made in 
OpenSCAD can still be used within your FreeCAD designs. The workbench also allows you to 
create new parts using OpenSCAD scripting directly. If you’ve solved a really hard geometry in 
OpenSCAD, this gives you not only the option of reusing that work, but also for that work to be 
enhanced using all of FreeCAD’s other tools.
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Whilst there are more than enough workbenches to get to grips with listed in Addon manager, 
there are also workbenches out in the community that aren’t included either in the main 
download or in the Addon manager. These are often in development and experimental in 
nature, but it can be fun if you find something in the community that relates to something you 
know about or are interested in.

Sometimes these workbenches are not included as development on them has ceased. 
However, often the open licences of these archived workbenches mean that someone could 
begin to work on them again. They also may still be functional nd of use. One excellent 
example is a workbench first released back in 2015: the Glider workbench enables the design 
of paragliding canopies and recently, in 2021, a forum member posted pictures of a paraglider 
in flight that had been designed with this innovative workbench.

Are you a developer? FreeCAD is always interested in attracting more developers to contribute 
to the software. The majority of the FreeCAD workbenches are written in Python. However, 
there are also some workbenches and areas of FreeCAD written in C++. 
There are many areas to look at, or perhaps you have your own idea for a tool that you’d like 
to create for FreeCAD, or an issue that you think you can solve.
The first port of call is the forum, and in particular ‘Developers corner’, where it would be a 
great idea to introduce yourself. Read the pinned thread, ’Read this first if you want to write 
code for FreeCAD’, to get the basic orientation of the FreeCAD developer community approach.

In this final part, we wanted to recap and expand upon other sources of help, should you need 
it, for FreeCAD. One of the best resources out there is the FreeCAD community forum – 
forum.freecadweb.org. We’ve mentioned it before, but it’s worth repeating a couple of points 
about the forum. First of all, there’s a really high chance that there is information that can help 
you with your particular situation already on the forum. It’s vast, and a search query for your 
subject will often return a heap of golden knowledge. It’s definitely worth searching before 
adding a new question or thread. 
Secondly, in order for community members to be well-equipped to answer a question, it’s 
really useful if you post basic information about your operating system, version of FreeCAD, 
etc. Wonderfully, FreeCAD has this built-in: if you go to Help > About FreeCAD from any 
workbench in FreeCAD, you will see your system information with a handy ‘Copy to clipboard’ 
button. Click the button and paste it into your opening post, followed by your question, and it 
may well make it much easier for someone to answer. 
Sometimes you’ll find that something in FreeCAD doesn’t work as you expect it to. Again, a 
good bit of forum searching and wiki reading will often yield a solution, but sometimes 
something might be broken. 
It’s always worth, and always preferred, that you search the forum, and post on the forum, 
checking if others have had your experience and allowing other community members to help 
identify if it is indeed a bug. If the consensus is that it is a bug, then someone in the 
community will raise it as an issue in the correct way or will inform back in the thread that the 
issue is a previously identified issue. Often, the answer will be that an issue in the current 
stable release version of FreeCAD has been addressed in the developmental version of 
FreeCAD. On that subject, the developmental versions of FreeCAD are always available for 
people to try. We’d suggest, as we have throughout these articles, that using the latest stable 
version whilst you are learning is recommended, but as you understand more it can be fun to 
try the developmental versions, which often show a sneak preview of new, interesting features 
and developments. Also, as FreeCAD is open source, there are some forked alternate versions 
of FreeCAD – this helps to keep FreeCAD development innovative, as the forked versions often 
explore different features and approaches. One popular forked version of FreeCAD, that 
contributes a lot of development back into the main FreeCAD branch, is the LinkStage3 fork by 
Realthunder – with some of the basics under your belt, you might like to try it out.
So, as we come to the end of this series, it’s perhaps worth considering where to look for other 
sources of information and tutorials on FreeCAD, as well as perhaps places to find some 
inspiration! First up for inspiration, new releases, and new feature announcements – and also a 
great place to see challenging, interesting work done in FreeCAD – is following the official 
@FreeCADNews account on Twitter. Watching that Twitter account, you’ll see the wide range of 
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approaches people use with FreeCAD and also come across people doing CAD challenges using 
FreeCAD and more. They often post using the hashtag #madewithfreecad, and it’s astonishing 
to see what people have made. 
YouTube is absolutely crammed with tutorial videos, and pretty much every area of FreeCAD is 
covered. One particular YouTube channel, Joko Engineering, deserves particular mention for 
excellent tutorials that not only cover using FreeCAD tools, but also often explore underlying 
CAD concepts.
We’ve mentioned it a few times, but the official FreeCAD documentation is in the form of a wiki 
and is available at wiki.freecad.org/Getting_started. All the built-in workbenches and tools are 
documented, and there are numerous short tutorials on different workbenches. It’s got heaps 
of information clearly laid out, and the wiki is already available in numerous languages. It also 
has wider reading on FreeCAD. 
A nice wiki entry that gives a quick-read version of FreeCAD’s origins and history can be found 
at wiki.freecadweb.org/History.
We hope this tutorial series has been useful, and we feel that if you worked through all 16 
parts, you would be pretty competent at modelling in FreeCAD. 
In our opinion, it’s definitely a process that requires practice, and with each new model you’ll 
find some area that requires a new approach to be explored and learnt. As such, it’s a great 
idea to work with FreeCAD as much as possible. One thing we have seen a lot of in the 
communications around this series is that often CAD communities have competitions or 
ongoing challenges which can not only be good fun, but also provide opportunities for you to 
expand and learn more approaches.
We’ve really enjoyed writing this longer series, which has been a new approach for HackSpace 
magazine, and we hope that you have enjoyed it. Many thanks to those of you that have 
worked through all the tutorials, reaching out to us on social media to share your progress. We 
continue to look forward to see what you can create using the brilliant FreeCAD platform. 
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Designing parts for CNC milling

>>>>>>WORK IN PROGRESS<<<<<<
Let’s explore FreeCAD for creating a simple 3D model and some toolpaths for CNC routing

We’re going to look at how to use FreeCAD to create designs that you can mill using a CNC 
machine. This way, you can create parts out of wood or metal potentially much larger and 
stronger than you can with other automatic fabrication methods such as 3D printing or laser 
cutting.
To begin, switch to the ‘Part’ workbench. For this project, you are going to design a simple disc 
with a hole and a pocket cut into it – not the most amazing project, but you can learn a lot 
along the way.
First, select a cylinder. 

Clicking the cylinder icon makes a cylinder appear on the right-hand side. You are going to 
eventually CNC-rout your flat disc from some 3.13 mm plywood – so let’s make this cylinder 
3.13 mm tall. Change this dimension in the dialog box of the Combo View on the lower left. 
Then change the radius to 26 mm.

You are now going to repeat the above process to make another cylinder; this should appear in 
the file tree as ‘cylinder001’. Change the size of this cylinder to a radius of 6 mm and a height 
of 2 mm. It will now appear to have disappeared, as it is underneath your original cylinder. In 
the dialog box, expand the ‘placement’ drop-down and then the ‘position’ drop-down, and let’s 
change the position of this cylinder. Change the z coordinate to 1.3 mm. This raises the 
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cylinder up 1.3 mm and sets the top of the cylinder flush with the top face of your original 
larger disc. Set the x axis position to 10 mm.

The next operation is to subtract the second smaller cylinder out of your first to leave a 2 mm 
deep pocket. To do this, hold the CTRL key down whilst selecting both the cylinders in the file 
tree. Next, find the ‘Make a cut of two shapes’ tool . Click the button, and the smaller cylinder 
should be cut out of the larger disc.
If at this point the larger disc disappears, press CTRL+Z to undo and reselect the two 
cylinders, but select them in the reverse order from what you did the first time and try again!
You repeated the above operation with a 2 mm radius, 10 mm tall cylinder to create the small 
hole through the piece, and you positioned this hole at -9 mm in the x axis.
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Walking The Path
Toolpaths are the path that a cutting tool follows. This, together with some information about 
the size and shape of the cutting tool and the speed and feed rates the tool is travelling at, will 
all be combined into a G-code file which you can send to a CNC router. To begin this process in 
FreeCAD, you need to switch to the Path workbench. 
Next, you need to select everything you have created (simply highlight the cut001 in the file 
tree view) and click the ‘Create a path job object’ tool icon. This button should be the only new 
icon that is available and not greyed out, appearing as a drill bit on the right-hand side of 
some green lines.

FreeCAD now will appear to have surrounded the disc you modelled with some lines, and a 
dialog box appears. FreeCAD has actually made a copy of the object, and has made the 
original object not visible. 
To toggle visibility of items in FreeCAD, you simply hover over them in the file tree view and 
press the SPACE bar. It’s important from now on that the original model is invisible, and that 
you work on the ‘Job’ model.
These lines, the bounding box, represent the stock material you are going to machine the disc 
out of. 
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As you are going to use 3.13 mm plywood that is the correct thickness, you don’t need any 
material above the surface of the disc. Therefore, you will adjust the z axis dimension of the 
bounding box in the ‘Setup’ dialog box to reduce the stock dimension to zero by changing the 
1.00 mm on the second Ext. Z axis column to 0.00 mm. 
Clicking ‘OK’, you should then be able to see that the top line of the bounding box is level with 
the top of your model. You are also going to change where the zero or datum is on your model. 
Double-click ‘Job’ in the file tree and then carefully select the node point at the left-hand 
corner of the bounding box on the level of the top of the bounding box. Having selected the 
node, click the ‘Set origin’ button. The red, green, and blue datum arrows should move to this 
corner now. This can be seen as the origin of the tool travel lines.

Next, you are going to create a new tool to use, and create a tool controller. To start this, click 
the icon that looks like three drill bits called ‘Tool Manager’. In the window that appears, click 
‘New tool’, and then, in the tool editor window that appears, you are going to specify the 
dimensions of a cutting bit. 
For all your CNC operations on this job, you will use the same tool – a 3 mm diameter, two-
flute end mill. Give your tool a name such as ‘3 mm end mill’ and set the ‘H’ to 15 mm (this is 
the available height of cutting surface on the tool, not the length of the entire bit). Click ‘OK’ to 
return to the ‘Tool Library’ window. Before closing this window, select the tool you just made 
and click the ‘Create Tool Controller(s)’ button (Figure 6). In the file tree, you should now have 
a tool controller that has the name of the tool you just created. Double-click on this and bring 
up a dialog box. In this Tool Control editor, you can set the feeds and speeds of this tool. You 
set ours to a conservative horizontal feed of 350 mm/min and a vertical feed of 100 mm/min.

The first toolpath you will generate is the path the tool takes to cut out the pocket for the small 
cylinder you placed, cut part-way through the larger disc. Select the bottom face of that hole 
and then click the ‘Create a path pocket object from a face or faces’ button. In the ‘Pocket 
Shapes’ dialog box, you then set the depth of cut on the ‘Depths’ tab – so you are starting 
from 0.00 mm and cutting down to -2.00 mm. 
And you are conservatively again going to step down in increments of 0.5 mm, so it’ll take four 
passes to cut this pocket. You also need to check the height clearances; on the Height tab, you 
set the safe height to 3.00 mm and the clearance height to 5.00 mm. Finally, on the 
‘Operation’ tab, you set the cut mode to ‘conventional’, the pattern to ‘spiral’, and the step over 
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percentage (the amount the tool moves outwards on the spiral after each turn as a percentage 
of the tool diameter) to 40%. Click the ‘Apply’ button and you should see your first toolpath 
appear on the model (Figure 7). Repeat the above section, but create a toolpath using the 
inside face of the through-hole. Follow the same process, but set the tool to a depth all the 
way through the disc.
You need to cut out the shape of the overall disc from the stock. To do this, you are going to 
select the whole model and select a ‘Profile based on face or faces’ operation instead of the 
pocket cut operation you used earlier. Select this and set the depths and heights.
You will notice under the ‘Operation’ tab that you have the option to set the tool to the inside 
or the outside of the path – set this to outside and the direction to CW.
Click ‘Apply’. If you cut this path in its current form, the workpiece would become loose as the 
machine cuts it out, and the work might be rapidly ejected! Adding ‘tags’ to the toolpath 
means that the machine leaves small tabs holding the part to the stock, and then you remove 
the part from the stock by hand. Make sure the profile path you just made is selected in the 
file tree view, and then click Path > Path Dressup > Tag Dressup from the main toolbar. In the 
resulting dialog box, you set the number of tags to 3, the width to 5.00 mm, and the height to 
1.2 mm. Clicking ‘Apply’ adds the tags – if you zoom in, you can see the tool has moved 
around the tags, leaving material.

Finally, you need to export your toolpaths as G-code, ready to be used with your CNC router. 
Double-click the ‘Job’ entry in the File System view. In the dialog box, click the Output tab to 
see various options (Figure 8). Different CNC machines use slightly different forms of G-code, 
and some have post-processors to ensure the code is exported in the correct format. FreeCAD 
has numerous built in, including the one you want to use: ‘grbl’, because the CNC router we’ll 
be using is controlled using the open-source Grbl system. You selected ‘grbl’ and added a 
location and a file name for your G-code file.
Grbl likes files with the suffix .nc, so you added this.
Click ‘OK’ on the dialog box and then use the ‘Post process the selected job’ option (next to the 
‘Create a path job object’ button you used earlier) and save the processed G-code file.

Quick Tips
For simplicity, we’re using the same tool to do everything in this tutorial. However, you might 
want to use a different tool and different operations. 
For example, you could drill the through-hole using a regular drill bit tool and a drilling 
operation.

When you have all your path operations set up, click the ‘Simulate Path G-code on Stock’ 
button to see a simulation of the tool performing the CNC routing. A useful check that 
everything is OK.

If your units don’t appear in mm/min, click Edit > Preferences and then, under the ‘Units’ tab, 
select ‘Metric small parts and CNC’ from the drop-down ‘User System’ menu.
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Community Forum

Asking for help with FreeCAD is something everyone who uses FreeCAD does or has done, and 
a great place to request assistance is on the FreeCAD community forum. The golden rule to 
remember is that everyone working on FreeCAD is a volunteer, so you need to do your best to 
make life easy, and be nice! Before you post, do a search on the forum for the topic you want 
to post about – the forum has been running for a long time, and chances are someone else has 
raised a similar discussion. You find that you barely need to post on the forum when you 
search first. You have also discovered all kinds of interesting approaches and techniques. 
Secondly, it’s really important when asking for some assistance that you describe which 
version of FreeCAD you are using and on which operating system. FreeCAD makes this really 
easy to do: just click Help > About FreeCAD, and you will see all the details of your installation 
listed. 

There’s a ’Copy to clipboard’ button; if you click it, you can then paste those details into your 
forum post before going on to ask your question. You should also do this if you are answering 
another thread or comment with additional information relevant to the post. While you are on 
the forum, remember every now and again to say thanks to the developers for voluntarily 
creating such great tools for us to use.
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